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What do you need help with today?

Removing trial restrictions
Activate Movavi Video Suite save videos without a watermark and remove all restrictions.

Recording screen
Capture any fragment of your screen or the full desktop.

Editing video
Create a movie from videos and photos

Capturing video
Record video from a camera.

Cutting video
Cut video files into multiple files or cut out scenes.

Burning files to DVD
Burn files and videos to DVD, create audio CDs.

Upload files to the web
Upload videos and photos to social networks in bulk.

 
Need more help?

Write to us at support@movavi.com
Or click here to open live chat.

 

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Activating Video Suite
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

 
Step 2:
•  Open the Movavi Video Suite launcher and click the Activate button.
•  Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
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Step 3: Enter your activation key and click Activate.

Activating without Internet access
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

 
Step 2:
•  Open the Movavi Video Suite launcher and click the Activate button.
•  Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.

Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
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Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should
receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Suite.

 

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used
before. Then, paste the registration key into the box and click Activate.

Trial limitations
When you first start your copy of Movavi Video Suite, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the main
features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Video Suite will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all output
videos

 No annoying watermarks

mailto:reg@movavi.com
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 Capture time is limited to 2 minutes per video  Unlimited capture time

 You can only convert half of each audio file and half of each video if
you use SuperSpeed mode

 Unlimited video and audio conversion

   Free updates
   Discounts on other Movavi products and upgrades
 
 
 

Edit video
Using the Video Editor, you can create your own movies using the media files you have on hand.  To open the Video Editor app, click Edit video on
the Video tab.

 
How to use the Editor?

Step 1: Add media
Add videos, photos, and music to your video project.

Open captured videos in the Editor
Record video
Record audio

Arrange files chronologically
 

Step 2: Edit video
Edit and enhance the video clips to

make your video just the way you like it.
Cut and split video

Rotate clips
Crop the frame

Apply cool filters
 
 

Step 3: Join clips with transitions
Drag-and-drop transitions from the Video Editor's

extensive collection to join clips with fun animations.

 
 

Step 4: Annotate your video
Get your thoughts across with sound and text.

Record a voice-over
Add text titles

Step 5: Save your video
Export your project to a common video format.

Save for devices
Save for uploading online

 
Making a movie

Jump to:
Creating project | Adding files | Cutting clips | Editing clips | Filters | Titles | Transitions | Saving the video

 
Step 1: Open the Video Editor
Open Movavi Video Suite and click Edit video in the Video tab to launch the video editing module.
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Step 2: Create a new project
When you open Movavi Video Editor, you will see a welcome screen. Click Create project in full feature mode to start making a video.
Learn more about projects

Step 3: Add videos, images and music
On the Import tab of the Video Editor, click Add Media Files to choose the video, audio, and image files you'll be using.
 

Learn more: Adding files | Recording video | Recording audio | Using built-in media

When you open the files, they will be placed on the Timeline: videos and photos on the video track, and audio clips on the audio track. To
rearrange the clips, simply drag them to the necessary position with the mouse.
 

Learn more: Using the Timeline | Working with video and images | Working with audio
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Step 4: Cut videos
1. Select the clip that you want to split.
2. Move the position marker onto the moment where you want to cut the clip. You can move the position marker both in the player or on the
Timeline.
3. Click the scissors button on the toolbar to split the video into two parts.

Learn more: Cutting video | Cutting audio

Step 5: Edit and enhance clips
Select the clip you want to edit and use the buttons on the toolbar to perform basic editing.

Learn more: Rotating clips | Cropping clips | Enhancing colors | Video properties | Audio properties
Step 6: Add filters
Filters can help you change the colors in your photos and videos or add an artistic touch. To apply a filter:
 
1. Click the Filters button to open the filter library. To preview a filter effect, click on its thumbnail.

2. Drag the filter's thumbnail down onto a clip on the Timeline to apply it. A star icon  will appear on the clip.
Learn more about filters
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Step 7: Join clips with transitions
1. Click the Transitions button on the left to open the list of transition styles that you can use to join clips.
2. Pick a transition you like and then drag it between two clips on the Timeline.
Learn more about transitions

Step 8: Add text titles
Use titles and callouts to annotate what's happening on the screen.
1. Click the Titles tab to open the list of available text styles.
2. Find a title style that you like and drag it onto the uppermost track of the Timeline.
3. After you've placed the title clip onto the Timeline, double-click the clip to edit the text and colors of the titles.

 
If you want to add arrows and shapes to your video, go to the Callouts tab and drag a shape onto the same track as the titles.

Learn more: Adding titles | Adding callouts
 

Step 9: Export the finished video
When you're finished with your movie, it's time to save it in a format that can be viewed in any video player.
 
1. Click the Export button to open the exporting options.
2. In the Export window, choose a format you want to save the video in, and name your movie.
3. Finally, click Start to begin processing the video. Your video will be ready in a few minutes.
Learn more about saving your video
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Tip: Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Having trouble with something?  E-mail us and we'll help you out! Our e-mail: support@movavi.com
In this guide, you will learn how to turn your photo albums into awesome slideshows complete with music and transitions. Creating a slideshow is
easy as 1-2-3 using the built-in Slideshow Wizard. Follow the instructions below to open the wizard and start making your own slideshow.
 
Open the Video Editor
Open Movavi Video Suite and click Edit video in the Video tab to launch the video editing module.

 
Create a new slideshow
•  On the welcome screen, click Slideshow wizard to open the three-step slideshow wizard.
•  Or open the File menu and choose New Slideshow.

Step 1: Add photos
Click +Files and +Folders to add photos to your slideshow. Organize and rotate your photos.
Learn more – Step 1: Add photos

mailto:support@movavi.com
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Step 2: Add transitions
Click the Step 2 button to go to the next step and choose a transition style you like.
Learn more – Step 2: Add transitions

Step 3: Add music
Click the Step 3 button to go to the next step and click +Audio to add some music. Then, trim the music as you see fit and set up music beats.
Learn more – Step 3: Add music

Step 4: Add titles and effects
Click Finish to generate your slideshow. Now you can add some finishing touches like filters, titles and special effects.
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Learn more:
Adding filters
Adding titles
Color adjustments
Removing black bars
 
Step 5: Save your slideshow
When you're done, click Export in the bottom right-hand corner of the window.
•  To save the slideshow as a video file, pick a video format and click Start.
•  If you want to share the video straight to YouTube, switch to the Upload online tab. There, sign in to your YouTube account, fill in the
information and click Start to save and upload the video.

Learn more:
Exporting videos
Uploading videos online

Step 1:  Add photos
1. In the first step of the Slideshow Wizard, click +Files to open individual images, or click +Folders to add entire folders to your slideshow.
 
2. An Explorer window will open. Choose the files or folders that you want to add.

3. Reorder your slides:
The slides will appear in the same order as you have added them. To rearrange the slides, simply click and drag them with your mouse to the
necessary position.
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4. Remove unwanted photos:
•  To remove one photo, hover your mouse pointer over it and click the trash can button that appears on top of it.
•  To remove several photos, select them in the list and click the trash can button beneath the slide list.
 
5. Rotate photos
•  To rotate one photo, hover your mouse pointer over it and click the rotation button that appears on top of it.
•  To rotate several photos, select them in the list and click the rotation button beneath the slide list.

Next step: Adding transitions
Step 2: Add transitions

Using transitions, you can join your photos with cool animations.
 
1. On the left side of the Slideshow Wizard, click the button with the number 2 to proceed to choosing transitions for your slideshow.
 
2. You will see a list of transition styles. Click on the one you like to choose that style.
 
3. In the Max transition duration box, enter a time in seconds to limit the maximum length of the transitions in your project. The length of each
transition is defined by the length of the slides it is joining, and by the beat of the music that we will add in the next step.
 
Limiting transition length helps you avoid transitions that are too long.
 
* Transitions cannot be longer than any of the slides in your project.
 

Next step: Adding music
Step 3: Add music

1. On the left side of the Slideshow Wizard, click the button with the number 3 to proceed to adding music.
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2. Add music:
 To add music, click the +Audio button and choose the audio files you want to use. If you don't have a suitable audio file, click 'Add one of our
tracks' to open the list of sample audio tracks and then click on a soundtrack in the list to add it.
The audio files will appear in the list. You can now preview and trim the audio clips.

3. Trim the audio
Click the play button to start playback.

Skip to the part where you want the audio to start and click the left bracket icon to trim the clip to this point.

Skip to the part where you want the audio to end and click the right bracket icon to trim the clip from this point.

4. Adjust slides to music beat
The Slideshow Wizard can analyze the music you've added and adjust the length of slides and transitions to fit the music tempo. Click the Yes
button in the Wizard to enable beat adjustment.
 
Then, enter the minimum slide duration to prevent slides from changing too fast.

5. Finish your slideshow
Click the Finish button in the Wizard to start processing your slideshow. When the slideshow is ready, click OK to close the Wizard. You can now
see your slideshow on the Timeline. Here, you can manually edit slides, or proceed straight to saving the slideshow.
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Step 4: Add titles and effects
When you've completed the Slideshow wizard, your slideshow will be ready on the Timeline. From here, you can proceed to saving it as a video file
or add some more cool effects.
 
Add filters
1. Click the Filters button on the left sidebar to open the filter collection.
2. Pick a filter you like and drag it onto the clip you want to apply it to.
Learn more about filters

Add titles
1. Click the Titles button on the left sidebar to open the text title collection.
2. Pick a text style you like and drag it onto the title track at the top of the Timeline.
3. Double-click on the title clip to change the text and edit the font, color, and other properties.
4. Click Apply in the editing panel above the player.
Learn more about titles

Crop photos
1. Select the photo you want to crop.
2. Click the Crop button on the toolbar.
3. A frame will appear in the player. Move the frame to the part of the screen you want to keep.
4. Click Apply on the Tools panel on the left.
Learn more about crop
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Adjust photos
1. Select the photo you want to adjust
2. Click the Color Adjustments button on the toolbar.
3. Choose the adjustments that make your picture better.
4. For more options, click Manual Adjustments and adjust the colors manually.
Learn more about color adjustments

Step 5: Save your slideshow
1. In the bottom right-hand corner of the window, click Export. The export settings window will open.

2. In the Export window, open the list at the top and choose a format for saving your slideshow.
 
3. Click Browse to choose where you want to save your slideshow file and name your slideshow in the File Name box.
 
4. Finally, click Start to save your slideshow as a video file. This may take a few minutes if the slideshow is very long.
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Creating and managing projects
A Movavi Video Editor project is a file in the *.mepx format that contains your work on creating a video. A project stores the locations of each
media file used in the project, as well as the edits, special effects, and settings that you use as you make your movie.
 
Creating a project
To create a new project, open the File menu and choose New Project. Then, choose Create project in full feature mode if you want to make a
movie, or choose Slideshow wizard if you want to make a quick slideshow.
Creating projects
 
Saving projects
To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and choose
Save Project.
Saving projects
 
Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie.
Learn how to open projects
 
Media use
When you add files to a project, Movavi Video Editor uses the original file for reference as you edit the movie. To save your disk space, Movavi
Video Editor does not make copies of the files, but rather remembers the location and name of the original file, so if you move or delete the files,
they will also disappear from the project.
Learn how to find missing files
 
Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve copies.
 
How can I play my project?
Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor, Movavi Screen Capture Studio, or
Movavi Video Suite. To view the finished work in a player, you need to first export your movie to a common video format.
Learn how to export your project

Creating a project
When you open Movavi Video Editor, a new project will already be created for you, so you can start editing right away.
 
Creating a new project
1. Open the File menu and choose New Project.
2. A welcome screen will appear. Click Create project in full feature mode to start making your movie.

•  If you want to make a quick slideshow, click Slideshow wizard on the welcome screen.
•  If you want to set up your project's size and other settings before starting, click Advanced project setup.

That's it! You can now start creating your movie.
 
Advanced project setup
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If you want to set up the project's frame size before starting, click Advanced project setup on the welcome screen. Then, specify the necessary
settings and click OK to start working on your project.

    
Resolution
The resolution is the width and height of your video in pixels. The higher a video's resolution, the more detail and quality of the original video it can
retain. Choose your project's resolution based on the videos and images that you plan to use in it.
 
You can choose from one of the resolution presets, or manually enter the width and height into the corresponding boxes.

Aspect ratio
A video or image's proportions are called the aspect ratio. It is the ratio of the video's width to its height, and is shown in parentheses next to the
project's resolution. While the most widespread aspect ratio is 16:9, others are also popular. Choose your project's aspect ratio depending on the
videos and images you plan to use in it.
 
If the project's aspect ratio is different from that of the files, you may see black bars around the edges of the frame. Learn how to fix black bars

 
Adding 4:3 photos to a 16:9 project and vice versa

 
Framing
When you add videos and photos to your project, they are scaled to fit the project's resolution and aspect ratio. Framing, or resize method, defines
how photos and videos will be placed inside the project's frame. This is especially important if you are using photos and videos that have different
aspect ratios and want to avoid black bars on the screen.
 

•   Letterbox - the photos and videos will retain their original proportions, and will be resized to fit entirely inside the frame. Leftover space in
the frame will appear as black bars.
 
•   Stretch - the photos and videos will be resized to fit inside the frame as best as possible, and then stretched to fill the remaining space.
This allows to fill the entire screen without black bars, but it may distort objects in the photos.
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•   Crop - the photos and videos will be resized in such a way as to fill the entire frame without changing their proportions at the expense of
cropping away the edges. This allows to fill the entire screen nicely, but some parts around the edges will not be visible.
 

FPS
The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan on
using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.
 
Sample rate
Just like digital video is made up of individual frames, digital audio is made up of tiny audio samples. Audio's sample rate defines how many of
these samples are taken in a second and is measured in Hertz (Hz). This affects audio quality. The default option, 44100 Hz, is suitable for most
projects.
 
Channels
This affects the number of channels in the project's audio. You can choose from mono (one channel) and stereo (two channel) sound, but stereo
is usually best for most projects.
 
Project settings
You can also change these settings later by clicking the pencil icon at the bottom of the window: .

See also:
Saving your work
Project settings
Exporting your movie

Project settings
Project settings affect your entire project and define how different kinds of videos, photos, and audio files are composed into your finished video.
You can set up your project's video and audio settings both when creating the project and at any other time.
 
Opening project settings
When creating a project:
When you create a new project or launch Movavi Video Editor, you will see a welcome screen. To change the settings before starting the project,
click Advanced project setup.

During editing:
•  On the bottom panel of Movavi Video Editor, find the pencil icon next to the information about your project. 
•  Open the Edit menu and choose Project Settings.
The Project Settings window will open.

Video settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to fit inside the selected
frame size according to your settings. 
 
Resolution
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The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of
the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to
make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

Frame Size Aspect Ratio
320x240 4:3
640x480 4:3

1280x720 16:9
1280x960 4:3

1920x1080 16:9
1920x1440 4:3

Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used generally for analog
TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio
different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a project
set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best results, we
recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project
Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering new

values:   – the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio;  – you can
freely enter the width and height with any proportions. Simply click this button to toggle the two states.
 
FPS
The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan on
using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.
 
Framing
Choosing a resize method can help you manage how all of your videos and photos are resized to fit inside the frame size you've set. This is
especially important when the aspect ratio of some videos and photos does not match the aspect ratio of the project and you need to get rid of
the black bars. There are three resizing options available:
 
Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame without
distortions, but may place black bars around the video.

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving black
bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.
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Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire area
of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips where
important objects are near the edge of the frame.

Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample
rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred
number of channels, however, some mobile devices record sound only in mono mode.

 

See also:
Creating a project
Saving projects
Opening projects
 
 
 

Saving projects
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore your work if you
need to edit something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the "\My Videos\Movavi Video Suite\Projects" folder
of your user. 
3. Click Save to confirm saving.

Later, you can open this project to continue working on your project.
 
Restoring work from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename
the "autosave.mepx" file and open in in the editor to continue working on your project.
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See also:
Finding missing files
Project settings
Exporting videos
 
 
 
 
 
 

Opening projects
Open a project to continue working on your video.
 
Where are my projects located?
By default, your projects are saved to "\Videos\Movavi Video Suite\Projects", but you can save your projects anywhere else you like.
 
How to open a project
A: Find your project in Explorer and drag it onto the Video Editor window.
 
B: Find your project in Explorer and double-click it to open it.
 
C: Click Open Project on the welcome screen. Then, locate the project file in the Explorer box and click Open.
 
D: Open the File menu and choose Open Project. Then, locate the project file in the Explorer box and click Open.
 
How to change where projects are saved
1. Open the Settings menu and choose Preferences.
2. Click the Files tab.
3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder. 

Finding missing files
When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one of the
files used in the project has been moved somewhere else or deleted from disk. 

 
•  If the file was moved elsewhere, click the Browse button and locate the file in the Explorer window. After that, you can continue working on the
project as usual: the file will be restored in its place on the timeline, as well as any other changes you have made.
 
•  If the file was deleted or you no longer wish to use it in the project, click Skip to open the project without the missing file.
 
•  To cancel loading the project, click Cancel. 
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Why is this happening?
In order to save disk space, the program does not copy the files you add to the project, but rather remembers their location on disk. Therefore, if
you move or delete the original files, it will no longer be able to use them as reference.
 

Adding media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Step 1: Open the Import tab
The Import tab is the first one you see when you start a new project. To open the Import tab, click the very first button in the upper left-hand
corner of the window.  

 
Step 2: Go to the My files section
In the left part of the Import tab, you can switch between adding your own media files or using built-in clips. Click on My files to show file import
options.

Step 3: Open files
1. Click Add Media Files.
2. A Explorer dialog box will open. Locate your files or folders and click Open.
 
If you want to add the entire contents of one or several folders, click Add Folder, select the folder(s) you want to use and then click Select Folder
to add the files.

Step 4: Arrange the files
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Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video. To
reorder the clips, select the clips you want to move and then drag them to the new position on the Timeline.
Learn about using the Timeline

Moving a clip on the Timeline

See also:
Working with video
Working with audio

Recoding video
Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A larger
resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while
static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.
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Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
 

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your project's Timeline. Also,
they are saved to disk in case you want to use them later.

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.
 
Step 1: Open audio recording options
On the toolbar, click the microphone button to open audio recording options.
* There must be at least one clip on the video track.

Step 2: Set up recording
1. In the Audio device box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try reconnecting
it to your computer.
 
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other sounds playing on
your computer.
 
2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
 
3. Set the volume level you want to use in your project.
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4. On the Timeline, place the progress marker to where you want the recording to begin. You will be able to move the clip later.
 

Step 3: Record sound
1. When you're ready, click Start Recording. You will be given a three-second countdown.
 
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to use the video as a
visual aid as you speak.
 
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.
* The recording will stop automatically if it reaches the end of the video track.

Importing AVCHD video
Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that the
system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.

audio_tracks.htm#linked_audio
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Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.

Using built-in media
Movavi Video Editor comes with an extensive collection of built-in media that you can use in your projects for free.
 
Step 1: Open the Import tab
Click the Import button in the upper left-hand corner to open the media options.
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Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.
 
•  Sounds – fun sound effects and audio samples to make your videos more expressive.
 
•  Music – instrumental tracks for your background music.
 
•  Sample video – video clips that you can use as intros, overlays, and animated backgrounds.
 
•  Backgrounds – image backdrops for your titles and transparent clips.

Step 3: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it onto the Timeline.

I can't use the stock media clips
The stock media clips are usually downloaded when you start Movavi Video Editor for the first time. If you don't have an Internet connection, the
stock media will be unavailable, but the clips will be downloaded the next time you connect to the Internet. Once downloaded, the clips will be
stored in your "\Videos\Movavi Video Suite\Media Content" folder.

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.
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See a clip's media information
To see a clip's media properties, right-click it on the clip Timeline and choose File Information from the menu.

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.

Using the Timeline
The Timeline, located in the bottom part of the window, is the working area that allows you to organize and edit the clips. The Timeline consists of
several tracks, which are all synchronized to a single time scale at the top, which indicates the time of the project. 
 
Timeline tracks
Your clips are arranged on tracks by media type:

•  Titles track – contains text and callout clips.
•  Overlay track – contains videos and images that are shown on top of other clips.
•  Video track – contains videos, images and the transitions between them.
•  Linked audio track – contains audio clips that are synchronized with the video track.
•  Independent audio track – contains audio clips that are not linked with the video track, such as background music.

Learn more about timeline tracks
 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use <TODO>: insert variable value here+click or click and drag to draw a
selection on the Timeline.

Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out, and move the slider
right to zoom in on the Timeline.
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Position marker
The position marker defines the currently selected point on the Timeline. There are two position markers: the orange line on the Timeline,
stretching down from the time scale all the way through all of the tracks, and the position marker on the progress bar of the player. Both denote
the current position relative to the whole project and show identical time.
 
The timestamp in the player displays the currently selected time from the beginning of the project.
Learn more about previewing clips

See also:
Creating overlays
Adding titles
Adding callouts
 

Timeline tracks
The Timeline is made up of several tracks, one for each media type, that allow you to arrange the clips in chronological order; mixing and joining
the clips together to create your unique video.
 
Video track
The video track contains video clips and their attached audio, images, and transitions between clips.
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.

 
Linked audio track
The linked audio track contains audio clips that are linked to video clips. At the beginning of each linked clip, you can see a blue line that connects
it to the video or image clip it is linked to. When you move, split, or delete the clip on the video track, the linked audio clip will also be edited with it.
This is useful if you've synchronized the clip's audio to the video track and don't want it to change as you edit your project.
•  The linked audio track is hidden at first, until you drag an audio clip between the independent audio track and the video track.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other.
 
Independent audio track
The separate audio track contains audio clips that are not dependent on clips on the video track. This track is good for background music.
•  You can edit the audio clips' volume and speed in the Tools tab.
•  You can have several audio clips playing simultaneously. To do that, simply place them one under the other. 
Learn more about audio tracks

Titles track
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The titles track contains text clips that will appear on top of all other clips.
•  You can change the titles' duration on the Tools tab, or by dragging the edge of the title's clip on the Timeline.
Learn how to place titles
 
Overlay track
The overlay track contains additional video and image clips to create special effects like Picture in Picture or Chroma Key.
•  Clips on the overlay track are linked to clips on the video track and will stay in sync as you edit the clips.
•  You can apply filters and use all of the Tools to edit the clips on this track, just like any other video or photo.
•  You cannot join clips on the overlay track with transitions.
Learn about using overlays
How to create a chroma key video
 
To select all clips on a single track, click the area with the track's icon to the very left of all clips.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.
 
Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the finished
video until you re-enable it.

Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player or on
the finished video.

Disabling tracks
To hide an entire track from view, click the eye icon  to the left of the track you want to hide.
 
To disable the sound for an entire track, click the speaker icon  to the left of the track.

Previewing clips
Use the player in the upper right-hand part of the window to preview your project.
 
Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.
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1 – player position marker
2 – current time
3 – previous frame
4 – play/pause

5 – next frame
6 – unpin player
7 – view in full screen mode
8 – player volume

 
Position marker
The position marker shows which part of your project is currently shown in the player. There are two position markers: one on the player's
progress bar, and another on the Timeline. Both of them move simultaneously and you can use whichever you like.

To move the position marker, do any of the following:
 
•  Click anywhere on the Timeline to move the position marker to that position.
 
•  Drag the position marker (either on the Timeline or in the player). For higher precision, try zooming in on the Timeline.
 
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds.
 
•  To move precisely from frame to frame, use the Previous frame and Next frame buttons in the player. This will move the position marker
exactly one frame backward or forward.
 
Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that, click
the Unpin player button under the player:

 
The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in the
detached player or close the player window.

How to undo actions
It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!
 
•  Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.
•  If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Y.
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Working with video and images
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and arrange
them into a movie. Next, it's time to edit and enhance the clips.
 
Cut video clips
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split the clip. Then, click
the scissors button on the toolbar to split the clip into two parts.

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
 

Learn more: Rotating video | Cropping video | Color adjustments | Volume | Speed | Reversing video | Image duration | Fades | Video properties

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to create
an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.
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Removing black bars
Some videos and photos may have black bars around them in the player. This can happen because the clip's proportions are different from the
project, for example, if you add a vertical video. To fix this, you can crop the video or use the special Vertical video fill filter.
Learn more about removing black bars
 
Creating freeze frames
A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast
movement or pause the action while you give additional information.
Learn more about freeze frames

Before and after adding a freeze frame
 

Video tracks
When you add videos or photos to your project, they are added to the video track of the Timeline. From there, you can rearrange the clips and
move them to other tracks.

Video track
The video track contains your videos with their built-in audio, photos and the transitions between them. To arrange clips on the video track, simply
drag them with your mouse.
 
•  You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
•  You can rotate, adjust, and use other tools on video and image clips on this track.
•  You can apply filters to video and image clips on this track.
•  You can also add titles to the video track, if you want to show them against a solid black background.
 
Overlay track
The overlay track is used to show a photo or video on top of the main video track. You can use overlays to show split screen footage or create a
chroma key effect.
 
To create an overlay, select a clip on the video track and drag it up, onto the overlay track. By default, new overlays are created in picture and
picture mode. To change the overlay mode, double-click the overlay clip and choose a mode in the control panel on top of the player.

Overlay modes: picture in picture, side by side, cover
 
 
•  You can add filters and any special effects to the overlay track.
•  You cannot use transitions on the overlay track.
•  Every overlay clip is linked to the corresponding clip on the video track.
Learn more about overlays
 
Linked clips
Clips on the titles, linked audio, and overlay tracks are all linked to a clip on the video track. You will see a line joining the beginning of the linked
track to a corresponding position on the video track. Whenever you move a clip on the video track, any clips linked to it will also move with it. This
allows you to keep clips synchronized as you edit the video.
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Linked overlay, titles, and audio tracks
Cutting video

Using Movavi Video Editor, you can easily split videos into parts and cut out fragments with the Split tool. You can find it on the toolbar of the
main window, marked with a scissors icon: 

Splitting video into parts
Step 1: Select the clip that you want to split.
Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.
Note that if the clip has linked audio, the audio clip will also be split.

Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch the
moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Step 2: Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the Timeline
will move to close the gap.

using_the_timeline.htm#position_marker
audio_tracks.htm#linked_audio
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Trimming videos
If you only need to cut off some parts at the beginning or at the end:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

 
For more precise navigation:
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+Left and Shift
+Ctrl+Right.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+Left and Ctrl+Right keyboard
shortcuts.

 
Rotating video

Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.
 
Rotating by 90 degrees
1. On the Timeline, select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.

Fixing the horizon level
1. On the Timeline, select the clip you want to rotate.
2. Click the Crop button on the toolbar to open the Crop tool above.
3. In the Crop tab, use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.
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Cropping video

Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open, and a cropping frame will appear inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it.

Use the options in the Crop tool on the left to modify the frame:
 
Constrain proportions: by default, the frame will have the same proportions as your project. If you want to change the proportions, deselect the
Constrain proportions option. However, note that black bars may appear around the video afterwards if the video's proportions are different from
the project's.
 
Angle: use the Angle slider to rotate the crop frame. This way, you can fix the horizon level.
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Step 4: Click Apply. A star  icon will appear on the clip once you've applied cropping.
 

Removing crop
To remove Crop or any other effect, click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and click
the Remove button to discard the effect.

Cropping all clips
Step 1: Open the Edit menu and choose Project Settings to edit your project. The Project Settings window will open.
 
Step 2: In the Resize Method box, choose Crop.
 
Step 3: Click OK. All the project's clips will be automatically cropped to the project's frame size.

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that isn't
enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments tool.
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Step 3: Use auto adjustments
Select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic Enhance option will
automatically determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and other
properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 

Video volume
This section explains how to manage the volume of video clips. To change the volume of audio clips, refer to the Volume levels section.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Clip Properties button to open the video properties for the selected clip.
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Step 3: Drag the Volume slider to set the volume for the selected clips.100% is the original volume.

•  To mute the clip, click the volume icon to the right: .
 
•  If the clip has a lot of volume peaks, try the Normalize option to raise the volume of quiet parts.

Video speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you want the
video to match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.
•  Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
•  You can also change the speed of any audio clip.
•  If you modify the speed of a video with built-in audio, the audio speed will also be changed.
 
Step 2: Click the Clip Properties button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.
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The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a star
icon:

Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter to
create a cool rewinding effect.
 
Step 1: On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
 
Step 2: On the toolbar, click the Clip Properties button to open the properties for the selected clip.

Step 3: In clip properties, select the Reverse option.

When you apply reverse, the clip will appear with a reverse icon on top of it:

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Clip Properties button to open the properties for the selected clip.
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Step 3: In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be
applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip appears
on the Timeline, the longer it will play in your movie or slideshow.

 
 

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading simultaneously
with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Video tab.
 
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.
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See also:
Adding transitions
Fading audio
 

Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.

The Tools panel will open on the Video tab, where you can edit the following:
 
Volume — Sets the volume of the clip's built-in audio.
Only for video clips with built-in audio.
 
Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.
 
Speed — Makes the video play faster or slower.
Only for video clips.
 
Reverse — Plays the video backwards.
Only for video clips.
 
Opacity — Affects the visibility of videos and images on the overlay track. Reduce the clip's opacity to make it more transparent.
Only for clips on the overlay track.
 
Duration — Sets the precise length of the image clip.
Only for images.
 
Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.
 
Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out.
For any clips.

See also:
Audio properties
Video volume
Video speed
Reversing video
Changing image duration
Fading video

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect, add a
logo or watermark, or insert a short clip without cutting the main video. Also, you can use overlays with the Chroma key tool.
 
Before you start:
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You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project.  You can use
images in PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move, cut, or
delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions may
make the overlay look distorted.

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.
2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is playing, the overlay clip
will appear on screen for the duration of the overlay clip.
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If you want to replace a video's background using the Chroma key effect, use Cover mode to place the foreground on top of the new background.
Learn how to use Chroma key. 

Cover overlay: left - the main clip is hidden; right - Cover with the Chroma Key effect
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip properties
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute  button, or
use the slider to lower the volume.
 
Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
 
Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to the
time it should take for the clip to appear.

See also:
Replacing video background with Chroma key
Using the Timeline
 
 

How to remove black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around them.
You can remove black bars from videos using one of the ways below.

 
Fill empty spaces
Using a special filter, you can fill the black bars with blurred parts of the video. This allows you to keep the entire video on screen and make it
more pleasant to view.
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button to open the Filters tab.
3. Find the Vertical video fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters
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Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

 
 
 
Automatic crop
If all or most of the clips have black bars around them, you can change the project's settings to either automatically crop all videos or change the
project's proportions.
1. On the bottom panel, click the pencil icon next to Project settings: . The Project Settings window will open.
2. In the Framing box, choose Crop.
Hint: If all of your photos have similar proportions, try using a different resolution.
3. Click OK to accept the changes. The videos will now be automatically cropped. 
Learn more about project settings

 
Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.
 
Step 1: Choose a frame
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Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame
and Next frame buttons under the player.

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

Step 3: Set duration
By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with your
own watermark or logo, or make a new one using text.
 
Image watermark
Step 1: On the Import tab, click Add Media Files and add the image or video that you want to use as the watermark. For the best look, use
images with transparent areas.
 
Step 2: Drag the watermark clip up to the overlay track to make it appear on top of other videos.

Step 3: Double-click the watermark clip to edit the overlay. Move and resize the overlay in the player and then click Apply when you're done.
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Step 4: To change the opacity, click the Clip Properties button and use the Opacity slider.
 
Step 5: To make the watermark show over the whole length of the video, enter your project length into the Duration box, or drag the right edge of
the overlay clip until the end of the video track.

Text watermark
Step 1: Click the Titles button on the left and pick a nice title style for your watermark.
 
Step 2: Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

Step 3: Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're
done.
 
Step 4: To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
HINT: If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.

Applying filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player.
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Step 2: Find a filter you like
•  On the left, you will see groups of filters. Click on a group to see the relevant filters.
•  If you're looking for a specific filter, enter its name into the search box under the group list.
•  If you really like a filter, click the heart icon to add it to the Favorites group. 

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters
1. Click on the star  icon on the clip to see the list of applied filters and tools.
2. In the list, select the filter that you don't want.
3. Click Remove.
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Special effects
With special effects, you can further enhance your videos and images to make your movie a masterpiece. You can find these enhancements and
special effects by clicking the More button in the left sidebar.

Zoom
With the Zoom tool, you can create a panning or zooming effect. Choose a zooming mode and then set the zoom target using the frame in the
player and click Apply.
Learn more

Zooming in, zooming out, and panning
Chroma key
Using the Chroma key tool, you can remove a color from an entire video and replace the background with any other video or photo.
Learn more

Replacing a green background with the Chroma Key effect.
Highlight and conceal
Use this tool to blur or darken a part of the video. This way you can hide certain objects, like license plates or other private information, or highlight
things you want to show!
Learn more

Left to right: conceal with pixels, matte conceal, blur highlight, matte highlight
 
 
Stabilizing videos
Use the stabilization tool to remove camera shake from your footage.
Learn more
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Before and after stabilizing
Pan and zoom

Using the Pan and Zoom tool, you can control camera movement using two keyframes. Set the beginning zoom and the end zoom using the
frames in the player, and the camera will smoothly move from one frame to the other.
 
Step 1: Open the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. On the left sidebar, click the Pan and Zoom button.
Tip: If you can't see Pan and Zoom button, maximize the window, or click the More button at the bottom and select Pan and Zoom from the pop-
up list.
 

Step 2: Add pan or zoom keyframes
1. On the Timeline, place the position marker to where you want the zooming to begin.
2. Select one of the zooming methods: Zoom in, Zoom out, or Pan.
Tip: To see how an effect works, select it and click Preview.
3. Click Add.

This will add two zoom keyframes to the clip. Using these keyframes, you can set up when the camera moves from one point to the other. The
camera will move between these two keyframes.

Step 3: Set up the zoom frames
Now, you can set the zoom level for each keyframe using the frame in the player, and the camera will smoothly move from one frame to the
other.
 
1. To change the starting keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the starting
point of the camera movement. 
 
2. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the ending
point of the camera movement.
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Step 4: Change the keyframe time
•  To change the length of the zoom effect, hold your mouse pointer over a keyframe and move it left or right.
 
•  To move the zooming effect without changing its length or other settings, hold your mouse pointer over the arrow and move it along the clip.
 
Step 5: Add more zooming (optional)
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in
on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

 
Removing zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove just
the selected keyframe, select Remove Keyframe.

Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken parts of the video.

Step 1: Open the Highlight and Conceal tool
1. On the Timeline, select the clip that you want to edit.
2. On the left sidebar, click the Highlight and Conceal button. The tool's options will open, and a frame will appear in the player.
Tip: If you don't see Highlight and Conceal button, click the More button at the bottom, and choose Highlight and Conceal from the pop-up list.

Step 2: Set up the mask
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1. In the Highlight and Conceal tool, open the box and choose Conceal if you want to hide an object, and Highlight if you want to bring attention
to the object.

2. Choose a shape for the mask: you can use a rectangle or an ellipse.
 
3. Choose a masking effect: blur, matte (black cover-up) or pixels. Use the options below to fine-tune the mask:
•  Opacity – makes the mask more transparent (for matte and blur)
•  Feathering – makes the edges of the mask softer (for matte and blur)
•  Size – changes the size of the pixels (for pixel masks only)
•  Outline – adds a white outline around the mask.

4. In the player, drag the corners of the mask to change its size and shape, and drag by the center of the mask to move it on top of the object.

Step 3: Add more masks (optional)
If you want to cover up or highlight more than one object, click Add Mask above the player to create another mask, and you can now set it up the
same way as the first. The selected mask is highlighted orange in the player.

Step 4: Apply the changes
When you're done, click Apply on the Highlight and Conceal panel to finalize the changes.
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Chroma key
How to replace a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to remove the
background from), use a clip with a bright, solid background that contrasts with the foreground objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player.
4. Click Apply.

Step 3: Open the Chroma Key tool
1. Select the foreground video on the Overlay track.
2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.
Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key
1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color you've
picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.
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2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar
colors to the one you've selected.
3. Use the Noise slider to determine how sharp the object's edges should be.
4. Use the Edges slider to determine how thick the object's edges should be.
5. Use the Opacity slider to set the transparency of the background.
6. Finally, click Apply to accept the changes.

Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars or empty areas along
the edges after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you walk or
move while filming.
 
Step 1: On the Timeline, select the clip you need to stabilize. Longer videos take more time to stabilize, so you may want to first cut the video
into smaller segments.
 
Step 2: On the left sidebar, click the Stabilization button.
Tip: if you don't see the Stabilization button, click the More button and select Stabilization from the pop-up list.

Step 3: Click Stabilize to open stabilization options. The Stabilization window will open.
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Step 4: Set up stabilization with the following parameters depending on the video and the amount of shaking:
 
Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
 
Shaking: set how strongly the shaking is visible on the video.
 
If you need more advanced settings, click the arrow under the sliders.
 
Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will
be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
 
Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
 
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.

•  None: the edges will remain as they are. Best results if there is little shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.

Step 5: Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.

Step 6: After the video has been stabilized, you will see its preview in the player. If you're satisfied with the result, click Apply to replace the clip
on the Timeline with the stabilized video. If you didn't like the results, repeat steps 4 and 5.
 
Stabilized copies
A stabilized copy of the file will be created under \My Videos\Movavi Video Suite\Stabilized. This copy will be used in the project instead of the
original video. If you delete the stabilized copy, it will be replaced with the original video, and you will need to stabilize the clip again.
 
Filming tips
•  When shooting videos, try to rest the camera on something.
•  If possible, use a tripod. Some tripods are really small and can fit into your bag.
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•  If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
•  Try to move around less. If you have to move the camera, do it slowly.
•  Check your camera's settings to see if it has built-in stabilization.
 

Troubleshooting
Not enough disk space error
When a video is stabilized, the Video Editor creates a stabilized copy of the video in a folder on your disk. By default, this folder is \My Videos
\Movavi Video Suite\Stabilized on your main disk drive. If you are running out of space on that drive, you can either free more space and try
again, or tell the program to save stabilized copies on another disk: 
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button  on the right to choose a different folder on a drive where you have more
space.
4. Click OK to accept the changes. Now, try stabilizing the video again. 
 
Cannot access folder error
This error means that you've changed the folder where stabilized files are stored, and that folder's permissions prevent the Editor from creating
files inside it. Try using a different folder for storing stabilized videos.

Working with audio
Add audio
To add music or other sounds to your project, click the Add Media Files button on the Import tab.

Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Audio tracks
When you add audio clips to your project, they will appear on one of the audio tracks at the bottom of the Timeline. There are two types of audio
track:
 
Linked audio track – each clip on this track is linked to a video clip on the main video track. This means that this clip will always stay
synchronized with this video.
 
Independent audio track – this is the standard video track, where audio clips such as background music will play independently from any other
tracks.
 
After you add the clips, you can rearrange them with your mouse and cut them just like video clips.

Learn more:
Audio tracks | Cutting audio | Looping audio

Volume
To change a clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools section above.
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Learn more:
Volume levels | Volume curves | Muting clips

 
Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.

Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection

Audio tracks
Audio in your project can be located on the video track as built-in audio, the linked audio track, or on the independent audio track. When you add
audio files to your project, they are first placed onto the independent audio track.

 Independent audio track
All new audio clips are added to the independent audio track. Audio clips on this track will play independently of any other tracks and will not
change when you edit other clips. This makes it suitable for background music.
 
 

 Linked audio track
Clips on the linked audio track are always linked to a clip on the main video track. This ensures that the clips stay in sync with the video even as
you edit your project and move or cut the clips. At first, this track is hidden until you link your first audio clip.
 
To link an audio clip:
1. Select the clip you want to link.
2. Drag it up, towards the video track. The linked audio clip will appear between the video and independent audio tracks.
3. A line will appear between the video and the audio clips. Place the audio clip on the linked audio track so that the line points to where it should
begin.
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Now, the audio is linked with the video clip that it points to. If you cut or delete the video clip, its linked audio clips (as well as titles and overlay
clips) will also be cut or deleted.

 

 Built-in audio on the video track
If a video clip has sound, both the video and audio will be added to the video track. The built-in audio is always together with its video, unless you
decide to move or delete the audio.
 
•  To separate built-in audio from its video clip, click on just the audio ribbon under the video clip, and then drag this ribbon down onto an audio
track. You can still keep the audio synchronized with the video by placing it on the linked audio track.

• 
 
To remove built-in audio, click on the audio ribbon under the video clip and click the trash icon .

 
Waveforms
Each audio clip's sound is represented as a waveform on the clip's ribbon. Waveforms can help you easily find the quietest and loudest parts of
the clip.

Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have as many sub-tracks as
you want. With music, you can use this to create a crossfade effect when you join songs: align the beginning of the second song with the end of
the first song to make them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.
Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed on
the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not need it.
 

Adding audio
You can add audio files in much the same way as you add video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Explorer dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.
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Use sample audio clips
If you don't have any suitable audio files, you can use free music tracks and sounds from the Movavi Video Suite audio collection.
1. On the Import tab, click Music if you need a background music track, or click Sounds if you need short audio samples. 
2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.
Learn more about sounds

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as blue ribbons. To change when the audio clip starts playing,
drag it along the Timeline, using the ruler at the top for time reference. 
Learn about audio tracks
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Extracting audio from videos

If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of the
Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video file, as
the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just cut
off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the fragment
will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

Step 3: Extract the audio
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down onto
the audio track. If you don't need the video clip anymore, go ahead and delete it.

You can now work with the extracted audio clip separately.
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Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.
Learn more about saving audio
 

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
Using sounds

You can make your movies more expressive using the built-in sound samples.
 
Step 1: Click the Import button to open the Import tab.
 
Step 2: On the left part of the Import tab, click Sounds to open the sound collection.

Step 3: Click on a sound to play it and pick a sound you like. Drag the sound onto the audio track of the Timeline.

Step 4: (optional) To synchronize the sound with a video clip:
1. Select the sound on the Timeline and drag it up towards the video track.
2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.
3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.

Cutting audio
Splitting audio
1. Select the clip that you want to split.
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2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

Trimming audio
To trim an audio clip from the beginning or from the end, hold your mouse pointer over the left or right edge of the clip and drag it towards the
center. The length of the audio clip on the Timeline reflects the length of the sound.

Cutting out parts
Let's say you want to cut out a fragment from the middle of an audio clip.
1. Place the position marker onto the beginning of the unwanted fragment and click the Split button.
2. Place the position marker onto the end of the unwanted fragment and click the Split button.
3. The fragment is now separated into a clip of its own. Select that clip and click the Remove button. The clip will be removed, and the remaining
clips will be moved up to close the gap.

For more precise navigation:
•  Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+Left and Shift
+Ctrl+Right.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+Left and Ctrl+Right keyboard
shortcuts.

Volume levels
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Audio Properties button to open the tools for the selected clip.
 
Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

•  To mute the clip, click the Mute  button on the right.
•  If parts of the audio clip are too quiet, select the Normalize option to increase their volume.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the
preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in the Video Editor,
and will not affect the output file.
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Volume curves
If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.
Learn more about volume curves

Audio clip with a volume curve
Volume curves

With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white line
on the image below is the volume curve before you add any points.

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Step 2: Add a volume point
Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point
from the pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point
to make the transition smoother.
 
Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment. 
 
Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This way,
only the adjacent parts will be adjusted, leaving the rest of the curve as it was.

 
Audio properties

To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio Properties
button on the toolbar.
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The Tools panel will open on the Audio tab, where you can edit the following:
 
Volume — Sets the volume of the clip.
 
Normalize — Makes the quiet parts louder.
 
Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.
 
Reverse — Plays the audio backwards.
Reversing built-in audio will also reverse the video.
 
Fade in — The audio fades in from complete silence to full volume in the time you set.
Fading built-in audio will also fade the video.
 
Fade out — The audio fades out from full volume to complete silence in the time you set.
Fading built-in audio will also fade the video.

See also:
Video properties
Equalizer
Volume curves

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Audio tab.
 
Fade in – how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full volume to silence at the end of the clip.
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Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.

Step 3: Choose an equalizer preset (optional)

Step 4: Drag the volume bars to adjust the frequencies to the necessary level.

0
Noise removal

Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise Removal.
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Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
•  Start with low levels and listen to the audio to check if the noise is gone.
•  Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

 
Audio effects

Audio effects can transform the sound of an audio clip.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio Effects.

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.
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Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.

See also:
Using sounds
Audio properties

Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then
adjust your movie to the beat of the music.
 
Step 1: On the Timeline, select the music that you want to detect beats for.
 
Step 2:  Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.

Step 3: In the Beat Detection tool, click Detect Beats. The program will analyze the music and place beat markers on the Timeline.

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make
the beat slower or faster.
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Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
 
Removing beat markers
•  To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
 
•  To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file play over again until the
end of the video.
 
Step 1:  Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the Ctrl+C
keys.
 
Step 2:  Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the
audio length is greater or equal to the video length.
 
Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and
drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

Hint: if you're making a slideshow, try using the Slideshow Wizard. There, the audio is automatically trimmed or looped to fit your project.
 
 

Adding transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions.

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline.
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A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
 
1. Double-click a transition on the Timeline to open transition properties.
 
2. In the Transition Properties window, enter the new transition length in the Duration field. The format is hours:minutes:seconds:milliseconds.
If you want all transitions that are currently in the project to have the same length, select the Set this duration for all transitions option.
 
3. Click OK to apply the changes.

Add transitions to all clips
You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions, use the
Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip in
your project.
4. Click OK to accept the changes.
Creating Slideshows
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Remove a transition
To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove Transition from the pop-up
menu. If you want to delete all the transitions in your project, choose Remove All Transitions.

Adding titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to preview its looks in the
player and choose the titles you want to use.

Step 2: Add a title clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track. A title
track will appear above the video track: drop the titles here, onto the time where you want them to appear. The titles will appear as a purple ribbon
on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or edit the video clip, its
titles will always stay in sync.
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If you already have a titles clip on the Timeline, you can add another clip onto the same timeframe to make them play simultaneously: simply
place one title clip under another.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing options
in the player.
 
Title clip properties

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and
animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click the

Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.

See also:
Adding callouts
Adding a timer
Title and callout track

Adding a timer
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Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of available text styles.

Step 2: Add Timer titles
1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should appear. To
change the length of the timer, drag at the edges of the clip.

Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab , set the duration and the format of the timer. The format determines which units of time are visible on the
timer: hours (hh), minutes (mm), seconds (ss), and milliseconds (zzz).

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click the
background color square and set Opacity to 0%.

5. On the Timer tab , enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
 
6. In the player, drag the Timer to the necessary location on screen.
 
7. Finally, click Apply to exit editing mode.



 

75

 
Title and callout track

Both titles and callouts appear on the Title track at the very top of the Timeline. Title and callout clips appear on the Timeline as purple ribbons.
You can also place title clips on the main video track, if you want them to appear on a black background.

A clip's length and position relative to the Timeline ruler shows when the titles will appear on the video.
 
Time
To change when the titles appear, drag them along the Timeline and place the beginning of the ribbon at the time when the titles should appear.
 
Length
To change the duration of the titles, hold your mouse pointer over the left or right edge of the clip and drag it to change the length.
 
Title synchronization
Every title and callout clip is linked to a clip on the main video track. A purple line connects the title or callout clip and the video clip. This allows you
to freely edit your videos without losing sync with the titles.
•  When you move the main video clip, any connected titles or callouts will be moved with it.
•  If you delete the main video clip, any connected titles or callouts will be deleted with it.
•  If you split the main video clip, any connected titles or callouts will also be split in the same position.
•  To link the titles or callouts to a different clip, drag the purple ribbon on the timeline over the clip you want to link it with.
 
Overlapping titles and callouts
You can play several titles and callouts simultaneously by overlapping them on the title track. Simply move one clip under another and they will
both show on screen at the designated time. On screen, the clips will be layered in the same order as they are on the Timeline.

The exclamation mark icon covers a part of the text bubble because its clip is at the top of the Timeline.
Saving custom titles

After you've set up titles to look the way you want, you can save that style and use it in your projects.
 
Step 1: Just like you usually edit titles, double-click the title clip and choose the font, color, and other options.
 
Step 2: Click the Save icon at the top of the title editing panel on top of the player.
 
Step 3: Enter a name for your titles and click Save.
 
The new title style will appear under the My titles group.
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Adding callouts
Using callouts, you can annotate your video with arrows, speech bubbles, icons, and other shapes.

Step 1: Open the Callouts tab
Click the Callouts button on the left sidebar to open the shape collection.
•  Click on a callout icon to see it in action.
•  Callouts are grouped into categories on the left. Use these to find the shapes you need.
•  If you're looking for a specific callout, type its name into the search box under the list of groups.

Step 2: Add callout clip
When you find a style you like, drag it onto the title track at the very top of the Timeline. Place the beginning of the clip where you want the callout
to start appearing. Drag the edges of the callout clip to change its duration.
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Note that the clip is linked to the corresponding clip on the main video track with a purple line. This means that the callout clip is synchronized
with the video: when you move or cut the video clip, the callout clip will follow without losing sync.
 
Step 3: Edit the callout
Double-click the callout clip. An editing panel will appear in the player. If the callout consists of several elements, for example, text and a shape or
two shapes, make sure to select the one you want to edit.

 
Position
In the player, drag the callout to where you want it to appear on screen.
 
Clip properties
•  On the editing panel, set the animation speed for the element to change how fast it appears on screen.
•  To change the callout's duration, enter it into the Duration box or drag the edge of the callout clip on the Timeline.
 
Colors

Click the Color properties icon  and choose the color and outline for the selected element.
 
Text
•  If the callout has text, double-click on the text box and enter the new text.

• 
 
Click the Text properties icon  and choose the new font, size and style for the callout text.

 
When you're done, click Apply to accept the changes and exit editing mode.

See also:
Title and callout track
Adding titles

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile devices, and so on.
This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about other ways
of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for TVs
Uploading videos online
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Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format
Open the list at the top of the window and choose a format for saving the video in.  Some formats allow you to choose which video codec you
want to use, and some allow you to save 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS and above.
 
If you don't know which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most platforms and operating
systems.

Step 3: Check your project settings
When saving standard video, the video will be exported with the same settings that were set for the project. This way, the output video will appear

exactly as you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the pencil icon  to view
and edit the project settings.
 
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you can set a lower
resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the
limitations of digital data compression. When changing resolutions, we recommend that you keep the same aspect ratio to avoid black bars
around the video or other unwanted distortions.
Learn more about project settings

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.
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Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path manually into
the box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: At the top of the Export window you will find a number of tabs. Click on the Save Only Audio tab.
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Step 3: Open the list at the top of the tab and select the format you'd like to save the audio in.
 
While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high audio
quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original files: due
to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and vice versa –
high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
 
When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project. The
audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example, MP3 is
limited to 320 Kbps, while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path manually into
the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 5: Click the Start button to begin processing the video file. This may take up to a few minutes. 

Uploading videos online
After you finish your video, you can share it to YouTube right from the export window.
 
Step 1: Open the Export window
1. Click the Export button to open the exporting window.
2. Switch to the Upload online tab.

Step 2: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let the Video Editor upload videos.
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Step 3: Choose a resolution
In the Export window, open the Resolution list and choose a resolution that suits your project.
•  For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the
bottom of the main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.
•  This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the website.

Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – only you can see the video.
•  Unlisted – the video will not appear for other people unless you give them the link.
•  Public – anyone can access the video.

Step 5: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify
your account.
YouTube help – increasing your upload limit 
3. Click Start to begin saving and uploading the video.

https://support.google.com/youtube/answer/71673?hl=en
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Export for TVs
This guide will help you export your video project for playing on Smart TVs.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Click the For TVs tab.

Step 3: Open the list at the top and choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs.

Step 4: Set export quality (optional)
Project settings: If you've been using the default project settings, your video's resolution is now 720p. To avoid losing quality when saving to

a larger resolution, click the pencil icon  and edit the project settings. There, choose the 1920x1080 resolution for 1080p HDTVs, and the
3840x2160 resolution for 4K Ultra HD TVs.
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Quality: If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher
bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a
small file size.

Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path manually into
the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Choose the necessary tab depending
on your type of device:
•  For Apple Devices: to save the video for devices made by Apple, including iPhones, iPads, iPods and Apple TV.
•  For Android Devices: to save the video for smartphones, tablets, and other devices running the Android operating system.
•  For Other Devices: to save the video for devices running neither iOS nor Android. These include Blackberry and Nokia smartphones, classic
mobile phones with 3GP and 3G2 video, Xbox, PlayStation, Zune, and others.
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Step 3: Once you've opened the necessary tab, open the list at the top and select your device or manufacturer from the list.
 
Note the Export Settings information, where you can view the properties for the output file. Due to the limitations of some devices, the video
resolution, audio quality, and other properties may be changed to adhere to the requirements of the selected device. Estimated File Size will give
you a rough estimate of how much disk space the file will occupy, which may be important if your device is running out of memory.

Step 4: Set export quality (optional).
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Explorer window, or enter the path manually into
the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Click the Start button to begin processing the video file. This may take up to a few minutes.

Editor preferences
To open the preferences:
1. Click the Settings menu
2. Select Preferences.
 
The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.
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When you're done, click OK to close the window and apply the preferences.

See also:
General preferences
File preferences
Acceleration preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version are
absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Show startup window when creating new project – with this option enabled, you will be prompted to select settings for the new project on
startup and when creating new projects. You can choose the project's aspect ratio and other settings, as well as open an existing project.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team, enabling
us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no personal
information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you see
an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics
cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software
replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If the Video Editor runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html
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File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different location.

 
Save project files to – this folder will by offered by default when saving and opening projects. This folder will also store any autosave files for
new projects. You can use the autosave file to restore your work in case of an error or force close.
 
Save output videos to – this folder will be offered by default when exporting media files.
 
Store audio recordings in – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip: if you delete these audio
files, the audio recordings in the project will also be unavailable.
 
Store stabilized videos in – when you stabilize a video, a stabilized copy of the original will be created in this folder and used instead of the
original. Tip: don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in another
way.

1. Click the button with three dots  next to the folder you want to change.
 
2. A Explorer dialog box will open. Choose the folder you want to save the files to.
 
3. Click Select Folder to use this folder. 

Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing you to
save your movies much faster and enjoy smoother performance.
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Enable Intel hardware acceleration
•  Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
•  This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
 
Enable NVENC hardware acceleration
•  With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.
•  Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
•  This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.
 
Troubleshooting
If acceleration options are unavailable:
•  Your computer might not have the right hardware.
•  If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
 

Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.
 
To sign in:
1. Click Sign In. The authentication page will open in the browser.

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor to upload videos to your account.

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
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4. Return to Movavi Video Editor. Your name will be shown in the Preferences window.
 
To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.

Convert files
Using the Converter application, you can change the format of video, audio and image files, convert files to play on devices or prepare files for
uploading online.
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What can I do with the converter?
Convert video files to a different format
Convert videos for watching on devices

Convert videos for uploading online
Convert audio files

Change image format
Create a GIF from a video

 
How to use the converter?

Step 1: Open the Converter app Step 2: Add files
Use the buttons at the top to open the files you want to convert.

Step 3: Choose an output format
Select the format you want to convert the files to.

Step 4: Edit and choose conversion options
Make changes to the files before conversion.

Audio tracks
Subtitle tracks
Reduce size

Step 5: Choose the output folder
Select the folder where the newly converted videos will be stored.

Step 6: Convert!
Click the Convert button to start processing the files.

Open the converter
To open the conversion app:
 
In the Movavi Video Suite launcher, click Convert video on the Video tab.

In the Movavi Video Suite launcher, click Convert audio on the Audio tab.

In the Movavi Video Suite launcher, click Convert images on the Photo tab.
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Converting video
 

Step 1: Open the converter app
In the Movavi Video Suite launcher, click Convert video in the Video tab. The Movavi Video Converter application will open.

Step 2: Open the videos
Before you start, you will need to open the videos in Movavi Video Converter.
1. Click the Add Media button at the top and choose Add Video from the pop-up menu.
2. A Explorer dialog box will open. Select the files you want to convert.
3. Click Open. The files will now be added to the file list.
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Step 3: Choose output format
In the lower half of the window, you will find a list of output formats.
1. Click the Video tab.
2. Click the format you want to use. For example, MOV.
3. Choose the preset with the codec and resolution that you want to use. To convert without changing the resolution, click the line marked "Same
as input". For example: "MOV", or "AVI MPEG-4 - Original size"
Customizing presets

Step 4: Edit and trim video
If you want to edit one of the videos, click the Edit button next to it to open the Editor window.
Choosing audio tracks
Choosing subtitle tracks
Trimming files

Step 5: Check output folder
At the bottom of the window, check the Save to box. This is where the output files will be saved. To use a different folder, click the folder icon 
and select the new output folder.
Changing output folder
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Finally, click the Convert button to start processing the videos. This may take anywhere from a few seconds to several hours, depending on the
size and number of video files.

Converting for social networks
Social networks like YouTube or Facebook don't accept all video formats. Follow the steps below to convert your videos to a format compatible
with the social networks.
 
Step 1: Open the videos
1. Click Add Media and choose Add Video from the pop-up menu.
2. A Explorer window will open. Choose the videos you want to convert and click Open. The videos will be added to the file list.

Step 2: Choose a social network preset
1. In the lower half of the window, click the Video tab to show all video formats.
2. Use the arrow oDn the right to scroll through the list and click the Online Video group.
3. Choose the social network and resolution that you want to use. This will set the optimal format and codec settings for uploading to this social
network.
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Step 3: Convert and share
1. Click the folder icon  next to the Save to box to choose where the output files will be stored.
2. To share the videos right away, click the Upload to button and choose the services that you want to upload videos to.
Note: to upload videos, you will need Movavi Share Online, a free add-on that you can use for batch uploading. If Share Online is not installed,
you will be prompted to download and install it .

3. Finally, click Convert to start converting the videos.



 

94

4. If you've selected sharing options, the files will open in Share Online as soon as conversion has finished. There, log in to the services, provide a
title and description for each video and click Upload.

Converting for the web
To upload a video online, whether to a personal website or to a video hosting service, you will need to do two things: convert it into a suitable
format and upload it onto the web.
 
Step 1: Open videos
1. Click the Add Media button and choose Add Video from the pop-up list.
2. A Explorer box will open. Select the files you want to convert and click Open.
How to open videos

Step 2: Choose a web preset
1. Click the Video tab for video output formats and presets.
2. Use the arrow on the right to scroll through the list and click the Web-Compatible Video group.
3. In the pop-up list, choose the format and resolution that you want to use.
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Step 3: Convert and upload
Check the Save to box to see where your web-ready files will be saved. To change the folder, click the folder icon . When you're ready, click
Convert to start processing your videos. When conversion is finished, you can start uploading your files to your blog or website.

Converting DVDs
The era of the DVD disc is coming to an end, and not all homes now have a DVD drive. Make your favorite movies future-proof by backing them
up to your computer.
 
Step 1: Open DVD
1. Insert the disc into your DVD drive. If you have an external DVD drive, connect it to the computer.
2. Click Add Media in the upper left-hand corner of the window.
3. Hold your mouse pointer over Add DVD.
4. Click the disc name in the menu that appears. If you don't see the DVD in the list, click Open DVD and find the DVD location.
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Tip: some DVDs are protected from illegal copying and cannot be converted. Movavi Video Suite is not intended for copying protected media.  
 
Step 2: Choose video format
1. In the lower part of the window, click the Video tab to see a list of video formats.
2. Choose the group with the format you like.
3. Click that format and pick a video resolution. To convert with the original resolution, choose the line marked with "Same as input".

Step 3: Choose files and streams (optional)
Many DVDs come with bonus clips, as well as a number of subtitle tracks. Select just the files you need to save disk space:
 
Bonus files
To remove bonus files that you don't need, click the  icon to the right of the video.
 
Audio tracks
1. Find the audio information in the right-hand part of the file list and click on it to open the list of audio tracks.
2. Deselect the audio tracks that you don't want to keep.
Learn more about audio tracks
 
Subtitles
1. Find the subtitle information in the right-hand part of the file list and click on it to open a list of available subtitles.
2. Choose the subtitle track that you want to keep.
Learn more about subtitles
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Step 4: Convert
The Save to box at the bottom shows where the DVD movies will be saved after conversion. To save the files to a different location, click the
folder icon and choose the new destination folder. When you're ready, click Convert to start processing the videos.

Creating GIFs from videos
Step 1: Open a video
1. Click Add Media in the upper left-hand corner of the window and choose Add Video from the pop-up menu.
2. Find the video you want to turn into a GIF and click Open.

Step 2: Trim the video
Usually, GIFs are pretty short, which means you'll need to trim the video to show just the important part.
1. Click the Edit button next to the video in the file list to open the Editor window.
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2. In the player, place the position marker to the beginning of the fragment you want to keep and click the scissors icon. This will cut the video into
two parts.
3. Move the position marker to the end of the fragment and click the scissors again.
4. Select the part you don't want to keep and click the trash can icon to delete it. Do the same for the other part you want to cut off.
5. Click Done to finish trimming and close the editor.
Learn more about trimming files

Step 3: Choose GIF format
1. In the lower half of the window, click the Images tab to see image formats.
2. Click GIF to see GIF conversion options.
3. Choose a size for your animated GIF. For example, "Medium GIF".
4. (Advanced) To change the frame rate, click the Customize button next to the output format at the bottom to customize the selected preset.
In the settings window, choose the frame rate you need and click OK. Higher frame rates will make the movements seem smoother, but will
increase the GIF's file size.
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Step 4: Save the GIF
Take a look at the Save to box at the bottom of the window: this is where the finished file will be created. To choose a different location, click the
folder icon  and select the new output folder. Click Convert to save your animated GIF.

Convert for devices
Each device has specific requirements to the type of video it can play, with some older devices supporting only a handful of video formats. To
make sure you'll be able to watch the videos on your device, convert them using the output preset created specifically for your device, and all
the necessary output settings will be selected automatically. This way, you don't have to look for what formats your phone supports, as it's all
selected for you.
 
Find your device automatically
If you're converting for a smartphone or tablet, connect the device via USB, and the converter will automatically detect it and recommend the best
output format.
Learn more
 
Step 1: Add files
Open the files you want to convert.
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Step 2: Open the Devices tab
In the lower half of the window, click the Devices tab so see a list of device presets.

Step 3: Find your brand
In the Devices list, use the arrows on the left and right to scroll through the list and find your device's manufacturer and click on it to see a list of
device models. 
If you don't see the device's brand in the list, try the search bar, or use a general category, such as Android, TVs, or Tablets.

Step 4: Find your device
Choose your device from the selected brand's list and click on it to select it as the output format. Now, the format, codec, and resolution is
automatically selected to be optimal for your device.

For example, to convert videos for the iPhone 6s, find Apple in the list, and then choose the iPhone 6s preset.
Step 5: Convert
Click the folder icon  next to Save to to select where you want to save the videos, and then click Convert to start processing the files.
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After the videos are ready, all you need is to upload them to the device.
 

* A preset is a pre-made configuration for a specific device that contains all necessary media properties required by this device.
Device recognition

Converting videos for devices such as smartphones and tablets is quick and easy: all you need to do is connect the device and the program will
suggest the recommended format and resolution for it.
 
Step 1: Add files
Drag the files you want to convert onto the converter window.
How to open files
 
Step 2: Connect the device
Connect the smartphone or tablet to your computer using a USB cord. 
 
Step 3: Confirm the device
1. Once the device is recognized, a dialog box will appear with the device name and the recommended preset. Check that the device name
matches your device. If the dialog box doesn't appear, click the Device Detection button to the right of the search bar.
2. If the device is correct, click Use These Settings to use the recommended output format, resolution, and other parameters.

Several devices are listed
Sometimes, the device detection box shows a list of several devices. This can happen if you have more than one connected device, or with some
devices that are very similar and can't be identified precisely. In this case, open the Choose your device list and select the device model that you
want to convert for. Then, click Use These Settings to use the recommended format, resolution, and other settings. 
 
Device was not detected
•  If the dialog box does not appear, try clicking the Device Detection button to the right of the search bar.
•  Try reconnecting the device and wait for the system to detect it.
•  If that doesn't help, you can still find a preset for your device manually on the Devices tab. Detailed instructions
 
The wrong device was detected
If the dialog box shows the wrong device, and that device isn't also connected to your computer, you can still find it manually on the Devices
tab of the preset list. If you want to report this mistake, write to us at support@movavi.com and tell us your device model, and which device was
shown instead.
Detailed instructions
 
Step 4: Convert!

mailto:support@movavi.com
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1. Click the folder icon  next to the Save to box and choose where to store the files after converting.
2. Click Convert to start converting the videos for your device.
3. After conversion has finished, upload the videos to your device and enjoy.

Disabling device detection
If you don't want to use device detection for any devices:
1. Click the Settings button and choose Preferences.
2. In the Preferences window, disable the "Recommend output format for connected devices" option.
3. Click OK to apply the changes.

Disabling detection for one device
If you don't want the device detection window to appear whenever you connect a specific device:
1. Connect the device and wait for the Device Detection window to appear.
2.  Select the "Don't show when I connect this device" option and close the window.

Converting audio
Even though MP3 is the most commonly used format, you may also encounter other formats, such as AAC or FLAC, which can preserve audio
quality better, but aren't supported by all devices. Converting audio will not only let you play music on any device or player, but also organize and
compress your media library.
 
Step 1: Open music
1. Click Add Media in the upper left-hand corner.
2. Click Add Audio in the pop-up list.
3. A Explorer dialog box will appear. Choose the audio files you want to convert.
Or simply drag the audio files onto the converter window.
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Step 2: Choose audio format
1. In the lower part of the window, click the Audio tab to see the list of audio formats.
2. Click the format you want to convert the audio to.
3. Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with "Original bitrate".
 
Bitrate – the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.

0
Step 3: Edit audio (optional)
Rename file
Renaming media files helps keep the music library in order.
1. Click the pencil icon  next to the file you want to rename.
2. Enter the file's new name.
3. Click OK.
Renaming files
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Normalize and manage volume
If some of your music files are quieter than others, you can normalize their sound so you don't have to adjust the volume every time you listen to
them.
1. Click the Edit button next to the file you want to normalize.
2. The Editor window will open. There, switch to the Audio tab.
3. Adjust the volume level or select the Normalize volume option.
4. Click Done.
Adjusting volume
 
Step 4: Convert and upload
1. To change where the files are stored, click the folder icon  next to the Save to box and choose the output folder.
2. If you want to upload the music to iTunes after converting, click Upload to at the bottom of the window and select iTunes from the pop-up
window.
3. When you're ready, click Convert to start the audio processing. Your files will be ready in a few minutes at most.

Converting images
Most applications and web services are limited to just a few image formats, and working with rare formats usually requires expensive software.
Convert images to be able to use them wherever you like!
 
Step 1: Open images
1. Click Add Media in the upper left-hand corner of the window.
2. Click Add Images in the pop-up menu.
3. Choose the images you want to convert and click Open.

Step 2: Choose format
1. In the lower half of the window, click the Images tab to see a list of image formats.
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2. Click the format you want to use.
Hint: not all formats support transparency. If the images have transparent areas, choose the PNG or BMP format. 

Step 3: Edit image (optional)
You can quickly fix or improve any images before converting. To do that, click the Edit button next to the image you want to adjust.

Learn more: Applying a watermark | Enhancing colors | Cropping videos and images
 
Step 4: Resize images (optional)
To batch resize the images:

1. At the bottom of the window, click the cogwheel icon  next to Output format.
 
2. Click the box under Frame size and choose a size that you want to use for all images, or choose any of the following and enter the size into the
width and height boxes on the right:

Custom: scales the images to exactly the size you specify.
Smart fit: scales the images up or down as close as possible to the specified size without changing the proportions.
Up to size: scales the images down as close as possible to the specified size without changing the proportions. Images smaller than this
size will remain unchanged.
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To allow changing the image proportions, click the link icon next to the width and height boxes:  – locked,  – unlocked.
 
3. If the new size is different from the original image proportions, choose a resize method for your images:

Letter box – unused space will be filled with black.
Stretch – the image will stretch to fill the entire area.
Crop – the image will be resized to fill the entire area, and overflowing edges will be cut off.
 

4. Click OK to accept the changes. If you want to preview the result, click the Edit button next to an image.

Step 5: Convert
1. Check the output folder in the Save to box. To change where the files are saved, click the folder icon  next to it.
2. Click Convert to start processing the images.

Opening media
To begin converting media files, you will first need to open them in Movavi Video Converter.
 
1. Click Add Media at the top of the window.
 
2. Click one of the buttons to open files of that media type.
 
3. A Explorer window will open. Find the files you want to convert and click Open to add them to the queue.
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Drag and drop from Explorer
Or simply drag the files from any Explorer window onto Movavi Video Converter to add them to the queue.

 
 

File list
After you have opened the files, they will all appear in the file list. Here, you can view information about the files, choose audio and subtitle tracks,
and manage the output file.

 
On the left, you can see the file's media information, and on the right you can manage the output file's name, media streams, and edit the file.
To remove a file from the list, click the X button on the right: 

Media streams
Every media file is made up of streams for each data type. A video can contain a video stream, a couple of audio streams, and several subtitle
streams. When converting files, you can find the information about these streams in two columns on the right. Here, you can manage the
streams that end up in the output file.
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Compress video
You can compress a video to reduce its output file size by sacrificing some of the quality. To do that, click the output file size and move the slider
to the necessary file size while keeping an eye on the quality.
Compressing videos
 
Choose audio tracks
If a file comes with a number of audio tracks for different languages, you can keep just the ones you need. To do that, click the audio stream and
deselect the audio tracks that you don't want to keep.
Choosing audio tracks
 
Choose a subtitle track
When you convert videos, you can permanently overlay subtitles on top of the video. To do that, click the subtitle stream and choose or add the
subtitle track that you want to use.
Choosing a subtitle track
 
Information about the original file
To find detailed information about the video and audio streams of the original file, right-click anywhere on the file and choose File Information
from the pop-up menu.
Media information

Choosing audio tracks
It isn't uncommon to find videos with several audio tracks, whether it's a different language or a director's commentary. Removing tracks you
don't need will reduce the output file size.
 
Step 1: Open audio track list
In the rightmost column of the file list, click the audio track information box. The audio track list will appear.

Step 2: Choose audio tracks
In the box with the audio tracks, deselect the audio tracks that you don't want to appear in the output video. If you want to completely remove
audio from the file, select the No Audio option.
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Step 3: Apply changes
Click Apply in the audio track box to accept the changes. Now, when you convert the videos, the output file will contain just the tracks you've
selected.
 

Note: not all formats support multiple audio tracks. The table below shows the maximum number of audio tracks for each format:
 

Format Number of audio tracks supported
3GP 1
AVI 16
DVD 8
FLV, SWF 1
MKV 16
MOV 16
MP4 16
MPEG-1, MPEG-2 16
OGV 1
WebM 16
WMV 16

Choosing a subtitle track
When you convert videos, you can permanently overlay any subtitle track onto the original video. This can be useful if you're watching videos on a
device, or your player doesn't support subtitles.
 
Step 1: Open the subtitle list
In the rightmost column of the file list, you can see the subtitle and audio track information for each file. Click the information next to the subtitle
balloon  to open the list of subtitles.

Step 2: Choose a subtitle track
In the subtitle list, click the subtitle track that you want to use.
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Adding subtitles from file
To add your own subtitles that aren't stored inside the original file, click the Add button above the subtitle list and then open the subtitle file that
you want to use.
 
Subtitle encoding
If the subtitle text looks scrambled, open the Subtitle encoding box and try setting the encoding with the right language.
 
Step 3: Preview the subtitles
Click the Edit button to see how the subtitles appear on the output video. For more subtitle editing options, click the Subtitles tab, where you can
edit the subtitle position and timing.
Editing subtitles

Extract audio from video
You can quickly save your favorite song from any movie by converting the video to an audio format.
 
Step 1: Open the video
Open the video file that you want to extract the soundtrack from.

Step 2: Trim the file
If you only need a short part of the soundtrack, you can cut off the rest of the file:
1. Click the Edit button next to the file to open the editor.
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2. On the Trim tab, use the scissors button to cut before and after the fragment you want to keep.
3. Select the fragments you don't want and click the trash can icon to delete them.
4. Click Done to accept the changes and close the editing window.
Learn more about trimming

Now, the output file will only contain the part you've selected.
 
Step 3: Choose an audio format
1. Click the Audio tab in the lower half of the window.
2. Click the audio format you want to use.
•  If you're not sure, use the MP3 format: it is supported by most players and allows for a decent quality.
•  If you want to convert audio with multichannel sound, you can use WAV, OGG, or FLAC formats.
3. Choose the necessary bitrate (quality) from the pop-up list. Choose Original bitrate if you want to keep the original quality.

Step 4: Convert
Click Convert to save the selected audio fragment.

Compressing videos
Compressing videos can help reduce the size of the output file by reducing their bitrate. When you compress a video, it loses some of its original
quality, but even a small bitrate reduction can make the file significantly smaller.
 
Step 1: Add files
Open the files you want to compress.
 
Step 2: Choose the output format
The video's format and resolution play a very important role in the output file size. 
 
1. Click the Video tab to see a list of video formats.
 
2. Click the format you want to convert the videos to.
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Hint: Some formats and codecs compress video better than others. If you're not sure which format to choose, use the MP4 format with the
H.264 codec for the best size to quality ratio.
 
3. From the format list, choose the resolution that you want to use.

Choosing the resolution
A video's resolution is the number of pixels in every frame. A higher resolution can preserve more information and quality, but it also requires more
disk space. Select a slightly lower resolution if the video is very large. For example, you can convert 1080p videos to 720p.
Learn more
 
Step 3: Compress video
1. In the file list, check the file's output size in the second column from the left.

2. Click the file size information to show compression options. There, drag the file size slider to the necessary file size while keeping an eye on
the quality below.
 
3. Click Apply in the compression box to accept the changes.

 
Step 4: Convert
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Click Convert to start processing the compressed file.

Media information
In the leftmost column of the file list, you can see the general information about the file, including its original size, video codec, resolution, and
bitrate.

To get more details, right-click the file and choose File Information from the pop-up menu. Here, you can see all the information about the original
file's video and audio streams.

Choosing output format
After you've added media files, it's time to choose the output format for converting all of the files in the list. Follow the steps below to choose a
video output format.
 
Step 1: In the lower half of the window, click the Video tab to see a list of video formats.
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Step 2: Click the video format that you want to convert the files to. A list of presets for this format will appear.

Step 3: Choose the video codec and resolution that you want to use.
To convert without changing the resolution, choose the preset marked with "Original size" or "Same as input".

Each preset displays information about the video, audio, and other output parameters that can help you choose the right one. 

Choosing the right resolution
A video's resolution is its size in pixels, horizontally and vertically. It is usually listed as the width times height: 1920x1080, or just the height:
1080p. This means that the video is 1920 pixels long and 1080 pixels tall. The higher a video's resolution, and the more pixels it has, the more
detail it can preserve.
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First of all, you need to know the original file's resolution. To do that, check the video information next to the file's preview. When you choose the
output resolution, select the same resolution to preserve the original quality, or choose a lower resolution to reduce the file size.
 
Advanced settings
If you can't find a suitable preset, you can select the necessary properties manually. Click the Customize button next to the 'Output format box to
modify the video and audio properties of the currently selected preset.
Learn more
 
 

Choosing a format for devices
If you are planning to watch some videos on your device, convert them first to save space and make sure that they can be opened with the built-in
player.
 
Step 1: Click the Devices tab in the lower half of the window.

Step 2: Use the arrows to scroll through the list and find your device's manufacturer.
 
Step 3: Click on the manufacturer to open the list of devices. Choose your device model from the list. Now, the output format, resolution and
other parameters have been set to what's best for this device.
If you cannot find your device in the list, try choosing a preset for a similar model.

See also:
Automatic device recognition

Choosing an image format
If you come across a rare image format, you can batch convert images to a more popular format.
 
Step 1: Click the Images tab to see a list of image formats.
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Step 2: Click the format you want to use and then click the preset for that format.
 
Social networking
Websites often have limits on the maximum image size you can upload. If you're planning to upload the photos to a social network or make an
avatar, click the Social Networking group and select where you want to upload the files. The image size and format will be set to those accepted
by the selected website.
 
GIF images
Using the image presets in the GIF format group, you can create both static and animated GIFs. Simply choose the GIF size that you want:
smaller GIFs will load much faster, but larger GIFs let you see all the detail.
How to create animated GIFs
 

See also:
How to convert images

Choosing an audio format
Follow the steps below to set an audio format for the output files. You can convert files with the original bitrate, or save space by converting FLAC
to MP3.
 
Step 1: In the lower part of the window, click the Audio tab to see the list of audio formats.

Step 2: Click the format you want to convert the audio to.
 
Step 3: Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with "Original bitrate".
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Bitrate – the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.

Customizing presets
 After selecting a preset, you can manually modify it to change any output properties. To do that, click the cogwheel button next to the Output
format box to open the settings for the selected preset.

To see more settings, click Show Advanced at the bottom of the settings window.
 
Two Pass Encoding
Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then to convert it using the
collected data. This takes extra conversion time, however it allows for a higher output quality and possibly a slight reduction in file size.
 
To enable two pass encoding:
1. Inside the Settings window, click Show Advanced to show the encoding settings.
2. Under Encoding type, choose Two Pass.
3. Click OK to accept the changes.

Editing media files
If you need to make some quick edits to the file before converting, click the Edit button next to the file that needs editing, and then apply the
necessary adjustments in the editing window.
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Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the file.
Learn more about trimming videos

Original video - 5 min. Trimmed video - 30 sec.
Joining videos
If your video footage is in several different files, you don't need to use a full-function video editor to join them together.
Learn more about joining files

Joined videos
Flipping and rotating videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Transform Video tool which lets you rotate and flip videos or
images.
Learn more about transforming videos

Left to right: original image, rotated 90° clockwise, rotated and flipped horizontally
Cropping videos
Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire screen when watching the
video. Cropping a video or image can also help to remove unwanted images from the edges of the screen (for example, if there's a dumpster at
the edge of an otherwise beautiful video!) or draw attention to the center of the frame.
Learn more about cropping

Cropping a video
 

Changing the aspect ratio
Changing the video's aspect ratio also lets you to make full use of available screen real estate without black bars. This is particularly useful if you
want to watch old TV-format videos on a new 16:9 screen, or vice versa.
Learn more about aspect ratios
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4:3 video turned into 16:9
Adding a watermark
Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Original video; image watermark; text watermark.
Adjusting colors
Using Movavi Video Converter, you can make quick color adjustments to your videos and photos. Use automatic adjustments for fast
enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Before and after adjustment
Stabilizing video
If your videos have a lot of camera shake, you can reduce the effects using video stabilization.
Learn how to stabilize video

Enhancing audio
Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat this, you can
normalize the file's audio track using Movavi Video Converter, or adjust the volume level manually.
Learn more about audio enhancements
 
 
 

Trimming files
Trim and cut files before converting to save disk space and keep just the parts that you want.
 
Step 1: Click the Edit button next to the file you want to trim.

Step 2: To cut out a part of the video:
 
1. Move the position marker to the beginning of the fragment and click the scissors button.
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If you're trimming the file from the beginning, skip to the next step.
 
2. Move the position marker to the end of the fragment and click the scissors button again.
If you're trimming the file from the end, skip to the next step.

3. Click on the fragment to select it and click the trash can button to remove it.

Repeat this for all other fragments that you want to remove. When you remove fragments, the rest of the video will seamlessly snap together.
 
Step 3: When you've removed all the parts you don't need, click Done to close the editing window.
 
Cancel trimming
If you want to remove the trimming and go back to the original length, click Reset on the Trim tab in the editing window.
 
Precise positioning
To set a cut marker more precisely:
•  Click on a cut marker to select it and move it along the seek bar to change the cut position.
•  Click on a cut marker and then enter the precise time into the box below it.
•  Click the skip forward or skip backward button to move the position marker or a selected cut marker by exactly one frame.

Rotating video
Use the Rotate tool in the editing window to rotate or flip videos and images.

 
Step 1: Click the Edit button next to the file you want to rotate. The editing window will open.

Step 2: Click the Rotate tab at the top of the editing window to show rotation options.
 
Step 3: Click one of the buttons to rotate or flip the file. The rotation buttons will rotate the file by 90 degrees with each click.
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Step 4: Click Apply to confirm the changes. If you want to rotate or flip all of the files in the same way, select the Apply to all files option.

Finally, click Done to close the editing window. Now, you can proceed to converting the files.
Cropping video

Cropping a video can help you remove parts around the edges or fix the video's aspect ratio.
 
Step 1: Click the Edit button next to the file you want to crop. The editing window will open.

Step 2: At the top of the editing window, click the Crop tab. 
 
Step 3: Set the crop frame to the necessary size and position:
 
•  Drag the edges of the frame to change its size, and drag by the center of the frame to move it relative to the entire video.
 
•  If you want a specific size, enter it into the width and height boxes.
 
•  If you want to crop the video to a specific aspect ratio, make sure that the Maintain aspect ratio option is enabled and choose the proportions
from the box below.
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Step 4: Click Apply to accept the changes.
 
Click Done to close the editing window, and then convert the files for the changes to take effect.

 
 

Adding a watermark
Use the watermarking tool to overlay any text or image over your videos and images.
 
 
Step 1: Click the Edit button next to the file you want to watermark.

Step 2: In the editing window, click the Watermark tab.

Step 3: Apply the watermark:
 
Text watermark
1. On the Watermark tab, click the Text button.
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2. Enter the watermark text into the box.
3. Click the buttons under the text box to change the font, text color, and outline color.
4. Move the Transparency slider to make the text more see-though.

Image watermark
1. On the Watermark tab, click the Image button.
2. Click the folder icon  and choose the watermark image you want to use.
3. Move the Transparency slider to make the image see-through and less distracting.
4. By default, the image will keep its original proportions. To change the proportions, deselect the Maintain aspect ratio option.

Step 4: In the player, move the watermark to the necessary position.
•  Drag at the corners to change the size of the watermark.
•  Drag at the center to move the watermark.

Step 5: Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same watermark to other
files in the list.
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Editing subtitles
Using the subtitle tool of the converter, you can permanently overlay a subtitle stream onto a video (also called 'hardsub'). This can be helpful if
you're planning to watch the videos on a mobile device or using a player that does not support separate subtitle tracks.
 
Step 1: Click the Edit button next to the video you want to add subtitles to. The editing window will open.

 
Step 2: In the editing window, switch to the Subtitles tab.

Step 3: Choose the subtitles that you want to use:
•  If the subtitles are built into the file, select the necessary subtitles from the list.
•  If the subtitles are stored as an external file, click Add and open the subtitle file.

Step 4: Set up the subtitles:
 
Subtitle encoding
If the subtitle text looks scrambled, try changing the subtitle encoding: open the list and choose the language or character set the subtitles should
be in.
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Position
Use the Position box to change where the subtitles appear on the screen:
1. Open the Position box and choose which edge the subtitles should snap to (e.g. top or bottom).
2. Use the slider below to move the subtitles relative to the selected position.
 
Synchronization
If the subtitles are out of sync with the video, use the synchronization box to advance or delay subtitles by a specific time in seconds and
milliseconds. Positive values make the subtitles appear later, and negative values make them appear earlier.
Example:
-0.100 – the subtitles will appear 100 milliseconds sooner.
1.200 – the subtitles will appear 1 second and 200 milliseconds later.

Step 5: Click Done to apply the changes. When you convert the video, the selected subtitles will be permanently shown over the video.

Adjusting colors
Not all videos turn out perfect: some may be slightly darker or less saturated than we want them to be. Luckily, you can adjust your videos'
brightness, contrast, hue, and saturation right from the converter!
 
Step 1: Click the Edit button next to the video or photo you want to adjust. The editing window will open.
 
Step 2: In the editing window, switch to the Adjustments tab.
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Step 3: Adjust the colors:
•  Drag the sliders to change the brightness, contrast, hue, and saturation of the photo and video.
•  Use the Magic Enhance option the automatically fix the brightness, contrast, and saturation of the video or photo.
•  If the colors look unnatural, try the Auto white balance option.

Step 4: When you're satisfied with what you see in the preview, click Apply. To batch-process other files in the list with the same adjustments,
select Apply to all files.

Finally, click Done to close the editing window. All that's left is to select an output format and click Convert to start video processing.
 
After you've edited the file, its thumbnail will now be marked with a star icon. You can right-click it to see a list of applied effects. To remove
adjustments, return to the Adjustments tab and click Reset at the bottom.



 

127

 

See also:
Noise removal
Rotating files
 
 

Video noise removal
Noise can appear on photos and videos if they were taken in poor lighting conditions. Follow these instructions to remove noise from any videos
or photos.
 
Step 1: Click the Edit button next to the video with noise. The editing window will open.
 
Step 2: Click the Adjustments tab in the editing window to show photo and video adjustment options.

Step 3: Select the Noise removal option.
 
Step 4: Move the Noise level slider to reflect the amount of noise you can see in the preview. The more noise you need to remove, the higher the
Noise level.

Step 5: When you're satisfied with the result, click Apply. If you need to remove noise from several similar files, select Apply to all files to use the
same noise level on all the files in the list.
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Click Done to close the editing window.
Enhancing audio

Using the audio tools in the converter, you can quickly fix quiet files or remove noise from the audio.
 
Step 1: Click the Edit button next to the file that needs audio correction. The editing window will open.
 
Step 2: At the top of the editing window, click the Audio tab.

Step 3: Adjust the volume:
•  To change the volume of the whole file, drag the Volume slider to the necessary level, where 100% is the original volume.
•  If parts of the file are too quiet, select the Normalize volume option to make them louder.
 
Step 4: If you hear hissing or other noise in the file:
1. Select the Remove noise option.
2. Drag the Noise level slider to set the amount of noise you can hear in the file.
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Step 5: When you're finished, click Apply to accept the changes. To fix the volume for all the files in the list, select Apply to all files.

If you don't need any further editing, click Done to close the editing window.
 
 
 

Low volume detection
When you add files to the converter, it will check the volume of the files and recommend steps if the volume is too low.
 
Step 1: Find low volume files
The converter will mark quiet files with the "Low volume" tag. Click the tag to see the recommended course of action.
 
Step 2: Boost volume
A message will appear, recommending volume adjustment. Click Boost Volume in the message to open the audio adjustments.

Step 3: Apply volume boost
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The Normalize volume option will already be selected for you. Play the file to check the new volume level. If you need more volume adjustment,
use the Volume slider to set the necessary volume level. Click Apply once you're satisfied with the new volume.

When you're finished, click Done to return to the main window.
Stabilizing video

Videos shot on handheld cameras often look shaky and unstable, no matter how hard you try to keep the camera level, especially if you're
filming sports using a portative action camera such as a GoPro®. To remove camera shake from your videos:
 
Step 1: Open the video files and click the Edit button next to the file that needs stabilization. 
 
Step 2: The editing window will open. There, switch to the Stabilization tab.

Step 3: Set up stabilization with the following parameters depending on the video and the amount of shaking:
 
Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
 
Shaking: set how strongly the shaking is visible on the video.
 
If you need more advanced settings, click the arrow under the sliders.
 
Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will
be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
 
Smoothing: limits camera acceleration. Higher values work best for more or less static videos.

•  If smoothing is less than or equal to the video's frame rate, the camera movement will be slowed down to
 
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.

•  None: the edges will remain as they are. Best results if there is little shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.
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Step 4: Click Apply to accept the changes. If you have several similar files, select Apply to all files to stabilize them in the same way.

If you're finished editing the file, click Done to go back to the main window. Stabilization will only take effect after you convert the videos.
Joining files

Step 1: Add the files you want to join
Click Add Media in the upper left-hand corner and choose Add Video from the pop-up menu. Open the files you want to join.

Step 2: Reorder files
The files will appear in the joined video in the same order as they are shown in the list. Drag the files with your mouse to the right order.
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Step 3: Join files
Select the Join files option at the bottom of the window. All the files in the list will now be queued for joining.

Step 4: Rename the output file
The output file will have the same name as the first file in the list. To change the name:
1. Click the pencil icon  at the top of the file list.
2. Enter the new name in the Output file name box.
3. Click OK.

Step 5: Convert
1. Select an output format for the new video. See also: Choosing output format
2. Click the folder icon  next to the Save to box and choose where to save the output video.
3. Click Convert to start joining the files.
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Troubleshooting
If you see an error after selecting the Join files option, make sure that all of the files in the list have the same number of audio tracks. Click the
audio information and disable the extra audio tracks. See also: Choosing audio tracks
 

Renaming files
Before you convert files, you can change the name of each output file.
 
Step 1: Click the pencil icon  next to the output file name in the second column of the file list.
 
Step 2: Enter the new name into the Output file name box.
 
Step 3: Click OK to accept the changes.

Now, the output file will be converted with this name.
Fixing the aspect ratio

Sometimes, when you watch videos on a display with different proportions, you may experience stretching or black bars around the edges. To
prevent that, you can change the video's proportions to adapt it to the display beforehand.

Black bars and stretching when watching a 4:3 video on a 16:9 screen.
What is the aspect ratio?
A video's aspect ratio is the ratio between its width and height. The two most commonly used aspect ratios are 4:3 and 16:9, the former used by
most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and modern HD video.
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A visual comparison of two popular aspect ratios.
Step 1: Click the Edit button next to the file that you want to fix.

Step 2: In the editing window, switch to the Crop tab.
 
Step 3: Make sure that the Maintain aspect ratio option is selected and choose your display's aspect ratio. This will set the crop frame to these
proportions.

Step 4: In the player, drag the frame's edges so that it covers as much of the video as possible. Drag the frame to the center of the video.
 
Step 5: Click Apply to accept the aspect ratio changes, and then click Done to close the editing window.

Now, after you convert the video, it will have the same aspect ratio as your display. 
Changing the output folder

When your files are converted, the new files will be created in the folder listed in the Save to box at the bottom of the window:
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To change where new files are stored, click the folder icon next to the Save to box and choose the folder you want to use.
 
If you want to save the new files in the same folder as the original files, click the arrow on the Save to box and choose Save converted files next
to the originals.

Sharing and exporting
After the files are converted, you can easily share them with your friends and family on the Internet.
 
Before you start
To upload files online, you will need the free Share Online application installed on your computer.
Download Share Online
 
Step 1: Prepare the files
1. Open the files you want to convert. Opening media
2. Choose an output format. Choosing output format
3. Edit the files. Editing media files
 
Step 2: Select services for uploading
1. At the bottom of the window, click the Upload to button.
2. Click YouTube, Facebook... in the pop-up list.
3. Another list will appear. Select the services or websites where you want to upload your files.

Step 3: Convert files
Click Convert to start processing your files. When conversion is finished, the Share Online window will open with the new files, ready to upload.

http://www.movavi.com/photo-video-uploader/
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Step 4: Upload files
If you haven't used Share Online before, you will be asked to log in to the websites you've selected.
Share Online uses the services' own authentification and does not store your login data to keep your privacy safe.
 
1. In the Share Online window, click a file in the list. Information about this file will appear on the right. Fill in the title, description, and privacy
settings for the selected websites. Repeat this for all files in the list.
 
2. Click Upload to start uploading the files to the selected services.

Uploading files to iTunes
Adding converted videos and music to your iTunes library will allow you to play them on any of your devices connected to the same iTunes
account.
 
Before you start
To upload files to iTunes, you will need iTunes 6.0 or higher installed on your computer. 
Download iTunes
 
Step 1: Prepare the files
1. Open the files you want to convert. Opening media
2. Choose an output format. Choosing output format
3. Edit the files. Editing media files
 
Step 2: Choose iTunes uploading
1. Click the Upload to button at the bottom of the window.
2. Select iTunes from the pop-up list.

https://www.apple.com/itunes/download/
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Step 3: Convert files
Click Convert to start processing your files. After conversion is completed, the files will be uploaded to your iTunes cloud storage.

iTunes® is a trademark of Apple Inc.
Energy-saving options

If you are running a batch conversion for very large files, the process may take a while even on fast computers. The energy-saving options allow
you to shut down or hibernate your computer after it is done converting the files.
 
1. Click the Settings button in the upper right-hand corner of the window.
 
2. Click the When finished menu to see the energy-saving options.
 
3. Select one of the following:
•  Do nothing – the conversion will run as usual, and your computer will stay on.
•  Hibernate – your computer will hibernate after conversion is completed.
•  Shut down – your computer will turn off after conversion is completed. We recommend that you close any other applications that may prevent
your computer from shutting down.

If you change your mind, you will be able to disable shutdown or hibernation during conversion. Please note that if you use any of the energy-
saving options, iTunes and web uploading will be temporarily disabled. The next time you start the converter, the energy-saving options will be
automatically turned off.
 
 

Watch Folder
The Watch Folder option can monitor a folder for changes and convert any new files to the format of your choice. If you frequently convert videos
to one format, you will only need to set it up once and then simply take the converted videos whenever you need them.
 
Setting up automatic conversion:
 
Step 1: Choose a format
Before you set up a Watch Folder, select the format that you want to convert the files to.
Choosing output format
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Step 2: Open Watch Folder options
Click the Watch Folder button at the top of the window to see folder monitoring options.

Step 3: Choose a folder
In the Watch Folder window, click the Browse button next to the 'Monitor folder' box and choose the folder you want to monitor and convert files
from.
For example, this can be your downloads folder if you want to convert any new videos you download.

 
 

Step 4: Set up conversion options
 
In the After conversion option, choose what you want to happen to the original files after they've been converted:

Delete original files: the files will be deleted as soon as they are finished converting.
Move original files to a subfolder: the original files will be moved to the 'Originals' folder inside the monitored folder. These files will not be
converted a second time.
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Launch at system startup: enable this option if you want the folder monitoring to resume after you restart the computer.
 
Show conversion notifications: select this option if you want to be notified every time a file has finished conversion or if there's an error.

 
Step 5: Start monitoring
Finally, click Start Watch Mode to begin monitoring the selected folder. The converter window will be minimized to tray and keep working in
background mode.

Conversion log:
If you've already used Watch Folder, you can see a detailed list of all conversion events that occurred in Watch Folder mode. To do that, open the
Watch Folder window and click View Log at the bottom. Here, you can see whether all files were converted correctly.
If you want to keep this log as a text file for future reference, click Save Log and choose a location for saving the log file. To delete all previous
entries, click Clear Log.
 

Accelerating conversion
Here are some things you can do to convert videos even faster.
 
Use SuperSpeed mode
When converting to a format with the same video codec as the original, SuperSpeed mode can convert videos up to 79x faster. To accelerate
conversion, use formats and presets marked with the SuperSPEED badge.
Learn more about SuperSpeed

Take advantage of your hardware
Movavi Video Suite is optimized for the latest hardware, allowing you to use your computer's full potential when converting videos.
 
NVIDIA hardware acceleration
If you have one of the latest NVIDIA graphics card that support the CUDA™ or NVENC™ technologies, you can enjoy faster conversion and
smoother performance by using the graphics card for video processing. When choosing an output format, look for presets with the NVIDIA
CUDA or NVIDIA NVENC badge.
Learn more about NVIDIA acceleration

Intel hardware acceleration
If you have one of the latest Intel® processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video. When
choosing an output format, use presets with the Intel HD Graphics™ badge to accelerate conversion.
Learn more about Intel acceleration

Enabling acceleration
To enable these acceleration options, click the Settings button in the converter window, and choose Preferences from the pop-up menu. In the
preferences, switch to the Acceleration tab and select the available acceleration options.
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Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

SuperSpeed conversion
SuperSpeed mode allows you to convert video files much faster than usual without losing any quality. When you convert videos, encoding the
video from one codec to another takes the most time. If you don't need to change the video codec or resolution, the video data can simply be
copied to the new file, without having to convert it. This is also sometimes called remultiplexing or remuxing.
 
When can it be used?
SuperSpeed mode can be used any time when the video stream in the output file is the same as the original:
•  The output codec is the same as the video codec in the original file (e.g. when converting MKV files with the H.264 codec to MP4 files with the
H.264 codec)
•  The output resolution is the same as the original
•  No video adjustments are used. This includes stabilization, video adjustments, denoising, subtitles, watermark, crop, and rotation.
•  No video compression is used.
•  You can still enjoy SuperSpeed conversion when trimming files.
 
How to use SuperSpeed conversion
To use SuperSpeed conversion mode, choose output presets marked with the SuperSpeed badge:

This can be a video format or a device preset that has the same codec and resolution as your original files. 
Intel® Hardware acceleration

If you have one of the latest Intel processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.
 
Compatible processors
Intel hardware acceleration is available on Intel® Core™ i3, i5, and i7 processor series. For a full list of processors that support integrated graphics,
please consult the Intel support center.
 
How to use Intel acceleration
You can enjoy Intel acceleration when converting videos to H.264 and MPEG-2 codecs. When selecting an output format, choose formats and
presets marked with the Intel® HD GRAPHICS badge. Conversion to these output formats will be accelerated.

http://www.intel.com/content/www/us/en/support/processors/000005718.html
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Troubleshooting:
Can't enable Intel® hardware acceleration
If the Intel® hardware acceleration option in Movavi Video Converter preferences is unavailable:
•  Check that your processor is compatible with Intel® hardware acceleration. To do that, open the Control Panel, go to System and
Maintenance, and choose System. Find the processor information and make sure that you have an i3, i5, or i7 Intel® processor.
•  Update the Intel processor drivers. You can find the newest version at Intel's official website here. We recommend only downloading drivers and
other software from trusted sources.
•  In order for the graphics acceleration to work properly, there needs to be a monitor connected to the graphics card port. Connect the monitor
and make sure it is functioning properly, then try enabling Intel® hardware acceleration again.
 
Problems while converting using Intel® hardware acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
•  Try updating the processor drivers. You can find the newest version at Intel's official website here.
•  Try disabling Intel acceleration in the preferences.

Intel HD Graphics is a trademark of Intel Corporation.
NVIDIA® Hardware acceleration

If you have one of the latest NVIDIA graphics cards, you can use its graphics processing power for converting videos. Using the graphics card
instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.
 
How to use NVIDIA acceleration
NVIDIA acceleration works when converting any videos to AVI, MP4, FLV, MOV, or MPEG-2 TS formats with the H.264 codec. To accelerate
conversion, choose one of these output formats marked with the NVIDIA CUDA or NVIDIA NVENC badge.

Compatible graphics cards
NVIDIA® CUDA™ acceleration supports GeForce, GeForce Mobile, Tesla, Quadro, and Quadro Mobile graphics card series. You can find the full list
of supported GPUs on NVIDIA®'s official site.
 
Using both the graphics card and the processor
If you don't need fast performance during video conversion or if you aren't planning on using the computer while the videos are converted, you
can enable parallel CPU and graphics card conversion to speed up conversion. To do that, select the Enable parallel CPU and NVIDIA GPU
conversion option on the Acceleration tab of the preferences.
 
Troubleshooting
How do I find out which GPU my computer has?
1. Right-click on your desktop and choose Display Resolution
2. In the Display Resolution window that appears, click Advanced. This will open your GPU's properties.
3. In the Adapter type section, you can see your GPU's model.

https://downloadcenter.intel.com/default.aspx
https://downloadcenter.intel.com/default.aspx
https://developer.nvidia.com/cuda-gpus
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The Enable NVIDIA® GPU Acceleration option is unavailable
If you can't enable NVIDIA® acceleration, try updating your graphics card drivers.
NVIDIA Download Center | Detailed Instructions
 
Problems while converting video with NVIDIA GPU acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
•  Try updating the graphics card driver. Detailed instructions
•  Try disabling NVIDIA GPU acceleration on the Acceleration tab of the preferences.

Saving a snapshot
To save a single frame from the video:
 
Step 1: Click the Play button on the video's thumbnail in the list to view the original file.

Step 2: In the player window, move to the frame you want to save and click the Take a Snapshot button.

Step 3: A Explorer window will open. Choose where you want to save the snapshot and click Save.
 

The snapshot will be saved with the original video's size and quality.
 

Movavi Video Converter Settings and Preferences
To open the converter preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.

http://www.nvidia.com/Download/index.aspx?lang=en-us
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The preferences are organized into tabs at the top: General, Conversion, and Acceleration. Click the related tab to find the preferences you need.
General preferences
Conversion preferences
Acceleration preferences

General preferences
On the General tab of the preferences, you can choose the interface language and control how the application behaves.

 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version are
absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team, enabling
us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no personal
information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Recommend output format for connected devices – when you connect a smartphone or tablet, the program will detect the device and
recommend the optimal format for watching videos on it. Learn more
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you see
an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics
cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software
replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If the program works without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 
Minimize to Watch Folder mode instead of closing – if you have enabled Watch Folder, closing the converter window will minimize the program
to the notification area, where it will still be monitoring the folder and converting files. Learn more

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html
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Conversion preferences
On the Conversion tab of the preferences, you can manage how files are converted.
 
Under Output file name, you can choose what happens if a file with the same name already exists in the output folder:
 
•  Overwrite existing file: the old file will be permanently replaced with the newly converted file.
•  Automatically rename files: new files will be automatically renamed, and both files will be preserved.
 
Under After conversion, you can choose what happens when conversion is finished:
 
•  Open output folder: shows the converted files in the output folder.
•  Play notification sound: the program will notify you when it has finished converting your files.

Acceleration preferences
On the Acceleration tab of the Preferences, you can accelerate conversion using the latest technologies. You can find out more about each
acceleration method in the Accelerating Conversion section.

Enable SuperSpeed conversion
•  SuperSpeed is an express conversion mode that converts compatible formats over 50x faster than regular conversion.
•  SuperSpeed works if the output codec is the same as the original codec, and no effects have been applied to the video.
•  When choosing an output format, look for presets with the SuperSPEED badge. This means that converting to this format will be much faster
than others.
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Enable Intel hardware acceleration
•  Accelerates video processing by up to 400% when converting H.264 and MPEG-2 video codecs.
•  This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
•  When choosing an output format, look for presets marked with the Intel HD GRAPHICS badge.

 
Convert using NVIDIA GPU
•  With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.
•  Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
•  This option is only available if your computer is equipped with an NVIDIA graphics card that supports CUDA™ or NVENC™.
•  When choosing an output format, look for presets marked with the NVIDIA NVENC or NVIDIA CUDA badge, depending on the acceleration
technology supported by your graphics card.

Enable parallel CPU and NVIDIA GPU conversion
If your computer supports NVIDIA GPU acceleration, the graphics card carries out the conversion, freeing up your CPU for other tasks. If you don't
need smooth performance while converting, or if you aren't using your computer during conversion, enable this option to use both the CPU and
NVIDIA GPU for converting video.
 
Troubleshooting
If acceleration options are unavailable:
•  Your computer might not have the right hardware.
•  If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

Record computer screen
With the screen capture module, you can record any part of your screen with audio and save the resulting video in any format you like.  When you
open Movavi Screen Capture, you will see a control panel window where you can set up your capture preferences and an orange frame which
allows you to select which part of the screen you want to record.

What can I do with Screen Capture?
Record screen

Record online video
Capture a Skype call

Capture video from players
Record audio

Record a tutorial
 

How to use Screen Capture
Step 1: Set up the capture area

Choose a full screen capture mode or click
the capture area button to select a window.

Step 2: Set up sound
Choose whether you want to record audio

from your speakers or the microphone.
Step 3: Extras

Use extra options to enrich your recording.
Schedule events
Highlight cursor

Step 4: Record screen
Start the recording by clicking the REC button.

Press F8 to take a snapshot.
Press F10 to start and stop the recording.

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
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Record keystrokes Press F9 to pause the recording.
Step 5: Save the result

Learn how to save your recording to a common media format.
Edit captured videos
Reduce output size

How to open the capture module
To open the screen capture module:
 
From launch module
In the Movavi Video Suite launcher, click Record computer screen on the Video tab.

From Video Editor
If you want to add a captured video to your movie, click the Record screencast button on the Import tab in the video editing module. The capture
module will open. After capturing your screen, click the Open in Editor button in the saving window. The recording will be added to your project in
Video Editor.

Recording video from screen
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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Step 2: Choose the capture area
First, you'll need to set which part of the screen you want to record.
 
To record the full screen
Open the list in the left part of the control panel and choose your display under Full Screen.

To record a window
On the capture control panel, click the capture area button and then click on the window you want to capture. An orange capture frame will
appear around the window, and the window's title will appear on top of the frame.

To record a custom fragment
On the capture control panel, click the capture area button. Then, click and drag to draw the capture area on the screen.
Learn more about the capture area

Step 3: Set up the sound
Recording system audio
1. Click the System Audio button to enable recording sounds and audio playing on your computer.
2. Use the slider on the left to set the necessary recording volume.

 
Recording from a microphone
1. Make sure that a microphone is connected to your computer.
2. Click the Microphone button to enable recording sounds from external devices.
3. Click the arrow above the Microphone button and select the device you want to use for recording.
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Step 4: Start recording
When you're ready to begin, click the REC button. You will be given a 5-second countdown before the recording begins.

Use these keyboard shortcuts to control the recording process:
F9 - pause the recording
F8 - take a snapshot of the capture area
F10 - end capture and save the recording
Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the preferences.

 
When you're ready to finish your recording, click Stop on the recording panel or use the F10 keyboard shortcut .
 
Step 5: Edit the recording (optional)
When you finish recording, the capture editor window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or save
it in a different format.
 
Cutting the recording
To cut out a fragment:
1. Place the position marker to the beginning of the unwanted fragment and click the scissors icon.
2. Move the position marker to the end of the fragment and click the scissors button again.
3. Move the position marker to the center of the fragment to select it and click the trash can button.

Saving the edited recording
To save the trimmed version, or to change the format of your recording:
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1. Click the Save As button. The output options will open.
2. Click one of the squares at the top to choose a format for saving your video.
3. Choose a name and location for saving the video.
4. Click Save to start processing your recording.

Frequently asked questions
I get a codec activation message when I try to start recording
When you first start using Movavi Video Suite, you need to activate the codecs you are using. Simply click Activate in the message box to start
using these codecs and continue with your capture. This process is free of charge and does not collect any personal information.

Recording online video
This manual describes how to capture videos from YouTube. You can also follow the same steps to capture video from other video sharing
websites (webinars, sports broadcasts and any other online video).
 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Define the capture area
In the Capture Area section, open the list of pre-defined capture area sizes and choose one from the YouTube section:
 

640х360 – default YouTube player size
854х480 – extended theatrical mode size. You can toggle sizes by clicking the Theatrical mode  button in the YouTube player. 

The capture area frame will be set to the selected size.
2. Place the frame over the YouTube player so that the player's control panel is outside the frame by dragging the frame by the orange position

icon .
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If you want to capture a fullscreen video, open the list of pre-defined sizes and choose the option under Fullscreen. If you have more than one
monitor, you will be able to choose which one to use for capturing video.
Learn more about capture area
 
Step 3: Enable system sound
1. Click the System Audio button to enable sound recording.
2. Use the slider to the left to set the necessary system audio volume.

Step 4: Record the video
1. To ensure the best recording quality, set the online video player to the highest quality and wait for the video to load.
2. Click the REC button to begin recording.

3. You will be given a 5-second countdown before recording starts. Use this time to enable full screen mode and click Play to start the video.
4. When the video ends, use the F10 keyboard shortcut to finish recording, or click Stop on the recording panel.

 
Step 5: Cut and convert the video (optional)
Your video is now ready. When you end the recording, you can play the finished video, cut out unwanted parts, or save it in a different format.
 
Trimming the video
If you've recorded extra bits at the beginning or at the end of the video:
1. Place the position marker to where you want to cut the video.
2. Click the scissors button to cut at the selected time.
3. Select the fragment you've cut and click the trash can icon to delete it.
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Saving the edited video
After you finish capture, your recording is already saved in MKV format. If you've cut the video or want to change the format, you will need to save
a copy of the video.
1. Click the Save As button in the editing window. The output options will appear.
2. At the top, choose the format for saving the new video. If you can't find the format you want, click the button next to More presets  and
search for the format or device preset that you need.

3. Name your file and click the button in the Save to  box to choose where to save the video.
4. Click Save to begin processing your recording. 

Recording with webcam
How to add a simultaneous webcam overlay to your videos

Step 1: Select capture area
1. Click the Select Capture Area button on the recording panel. Your cursor will turn into a crosshair.
2. With the crosshair, select the part of the screen that you want to record.

 
Step 2: Set up the webcam
1. Connect the webcam to your computer and wait until the system installs the necessary drivers.
2. Click the cogwheel icon on top of the Webcam button. The webcam preferences will open.
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3. Under Use this webcam, choose the webcam device that you want to use and check that its preview appears on the right.
 
4. Set up the video options for this webcam:
 
•  Click the Properties button to set up your webcam's options such as brightness, contrast, and exposure. Note: webcam settings are different
for each model.
 
•  Choose the resolution that you would like to use. The higher the resolution, the higher the webcam video quality will be. However, if the webcam
video is small, you may not need a very large resolution.
 
•  For the best quality, use the highest frame rate that your webcam can provide for the best quality. If your webcam is mostly static or if you want
a smaller file size, you may want to use a lower frame rate.
 
5. Set up the size and position for your webcam:
 
•  Use the Video size slider to set the size of the webcam picture relative to the entire video.
 
•  Choose one of the Position options to place your webcam picture inside the frame.
 
6. Click OK to save the webcam preferences.

Now that you've set up the webcam, the next time you want to use it, simply click the Webcam button once to enable webcam recording.
 
Step 3:  Set up sound
Next, choose the audio sources that you want to hear on your recording:
 
System sounds
To record music and other sounds playing on your computer, click the System Audio button. The button appears green when enabled.
 
Microphone
You can record audio from your webcam's built-in microphone, or use an external microphone for better sound quality:
1. Click the Microphone button to enable recording from external devices.
2. Click the arrow above and choose the microphone you want to use from the list.
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Step 4: Record your video
When you're ready to begin, click REC to start recording. The recording panel will be minimized during recording.

To finish the recording, press F10 or click Stop on the recording panel.
 
Step 5: Edit and save
When the recording is finished, it will open in the capture editor, where you can play or trim the result.

To cut or trim the video, use the scissors and trash can buttons on the toolbar. If you've trimmed the file or if you want to save your recording in a
different format, click Save As.

Recording video from players
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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Step 2: Set up the capture area
 
Note the quality and resolution of your video. For best video quality, it is recommended that you record the video as close to its real resolution as
possible.
•  If the video is larger than your screen, maximize the player window and record the full screen.
•  If the video is smaller than your screen, set the player settings to display the actual size. In this case, stretching the video to the full screen will
decrease the quality.
 
To set a fullscreen capture area:
In the Capture Area section, open the list of pre-defined capture area sizes and select an option under Fullscreen. If you have more than one
monitor, you can choose which display to use for fullscreen capturing.
 
To capture a player window:
Click the Select Capture Area button in the Capture Area section to enable smart capture area selection. The screen will dim slightly. Then,
draw the capture area inside the player, so that the player's window is completely outside the frame. When you release the mouse button, this
rectangle will be set as your capture area.
Learn more about the capture area

Step 3: Set up the sound
After you've selected the capture area, the recording panel will appear. Use the panel to set up the recording options.
 
1. To enable recording sounds from the player, click the speaker button under System Audio. The button will appear green when enabled.
2. Use the slider to the left of the speaker button to set the volume of the player's recording.
3. To make sure that  other sounds don't interfere with your recording, check that the Microphone button is disabled (black), and close other
windows or browser tabs that might play sounds during your recording.

Step 4: Record video
When you're ready, click the REC button on the recording panel and start playback in the player. The recording panel will hide
Tip: You can trim the beginning later, so don't worry if you start playback after recording has begun.
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To end the recording, press F10 or click Stop on the recording panel.
 
Step 5: Edit and convert (optional)
Your recording is ready and saved in MKV format, and you can view the result in the capture editor. Now, you can trim the video or convert it to a
different format.
 
1. To trim the video from the beginning or from the end, move the position marker to where you want to trim the video and click the scissors
button to cut off the fragment. Then, select the unwanted fragment and click the trash can button to delete the fragment.

2. Click the Save As button to open output options.
 
3. At the top of the window, select the format you want to save the recording in.
If you don't see the format you want to use, click the More presets button and choose the necessary format on the Video and audio tab.
 
4. Under File name, enter a name for the new video. Then, click the button under Save to and choose where you want to save the video.
 
5. Click Save to start processing the new file.
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Troubleshooting
Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are having trouble recording
video from any of the following players, follow the steps to change the player's settings and enable video capturing.
 
Capturing video from VLC (VideoLan Media Player)
(for Windows XP users)
1. In VLC player, open the Tools menu and choose Preferences.
2. Switch to the Video tab (in Simple mode)
3. In the Display section, find the Output list. If DirectX (DirectDraw) video output is selected, try using a different output mode.
 
Capturing video from Media Player Classic
(for Windows XP users)
1. In Media Player Classic, open the View menu and select Options.
2. Go to the Playback > Output section in the tree on the left.
3. Find the DirectShow Video option. Here, you can choose from a list of video renderers that will affect how the player displays video on your
screen. If the Overlay Mixer Renderer is selected, select any other renderer from this list.
4. Click OK to accept the changes.
 
Capturing video from Windows Media Player
(for Windows XP users)
1. In the main player menu, open the Tools menu and select Options.
2. In the Options window, switch to the Performance tab.
3. Click the Advanced button.
4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.

Recording Skype calls
When you record audio or video calls using Skype or a similar program, it is important that you record both ends of the conversation. To do that,
you will need to record input from your microphone or webcam, as well as the audio from your speakers. Follow the steps below to record Skype
calls with audio.

 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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Step 2:  Set up the sound
Here, you can choose which sound sources can be heard on your recording.
1. Click the speaker button under System Audio to enable recording sounds on your computer, including the call from the other end.  The button
appears green when enabled.
2. Click the Microphone button to enable recording from a microphone. If you have more than one microphone, click Microphone and choose
the one you want to use for the recording.
3. Use the sliders to the left of each button to set the necessary volume levels for the call and for your microphone.

Tip: if you're recording a video call, you do not need to enable webcam recording in Movavi Video Suite, because Skype is already recording your
webcam.
 
Step 3: Set up the capture area
Adjust the size of the Capture Area to the call window. To do that, click the Select Capture Area button in the left part of the window, and then
click and drag your mouse from one corner of the Skype call area to another. When you release the mouse button, the Capture Area will have the
same size and position as your Skype window.
You can find more information on how to set the size and position of the Capture Area in the Defining the Capture Area section.
 

Step 3: Record your call
1. Start your call in the Skype window.
2. Click REC on the Movavi Video Suite panel to begin recording.
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3. When you finish your call, press F10 or click the Stop button on the recording panel to finish recording. The capture editor will appear, where
you can play the finished video, cut the recording, or save it in a different format.

Step 4: Edit and convert (optional)
If your recording started before the call, you can trim off the extra bits using the scissors and trash can buttons.
 
1. Place the position marker to where you want the video to start and click the scissors button.
 
2. Select the unwanted fragment and click the trash can button to delete it.

3. Now that you've cut the video, you need to save the trimmed copy. To do that, click the Save As button.
 
4. The export options will open in a new window. There, select the format you want to use, name the file and choose where you want to save it,
and click Save to start processing the video.
Tip: If you want to save just the audio of the call without the video, select MP3 or any other audio format when you save the recording.
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Making an animated GIF

To create a GIF, all you need to do is record an action or video on the screen and then save the animation in the GIF format.
 
Step 1: Select capture area
1. Click the Select Capture Area button on the recording panel. Your cursor will turn into a crosshair.
2. With the crosshair, select the part of the screen that you want to record.

If you need to adjust the capture area, drag its edges to change the size and drag the square  in the center to change its position.
 
Step 2: Record the action
Once everything is ready, click the orange REC button to begin recording your GIF.

When you've finished your recording, press F10 or click Stop on the control panel. Don't worry if you accidentally record more than you need, you
can trim the recording later.
 
Step 3: Trim and save your GIF
After capture is complete, you will see your recording in the capture editor window.
 
Trimming the GIF (optional)
If you've recorded extra bits, you can cut them off:
1. Place the position marker to where you want to cut the video.
2. Click the scissors button to make a cut.
3. Select the fragment you want to remove and click the trash can button.



 

160

 
Saving the GIF
1. Click the Save As button to open output options.
2. Click the GIF square at the top to choose GIF as the output format.
Advanced: If you need to edit the size and quality of the GIF, click the cogwheel button next to Output format.
3. Name your GIF file and choose where you want to store it.
4. Click Save to start turning the recording into an animated GIF.

Fun fact!
The creators of this format intended it to be pronounced as 'jif', but it is now more

common to pronounce it with a hard 'g', so both pronunciations are accepted.

Record audio only

Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.
 
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.
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Note that you can also record audio using the Record sound button on the Audio tab.
 
Step 2: Set up the audio
On the recording panel, choose which audio sources you want to record from:

Recording system sounds
To record music, online videos, and any other sounds playing on your computer, click the System Audio button.

off              on
 

Recording microphone audio
To record sound from a microphone or any other recording device connected to your computer, click the Microphone button. If you have more
than one recording device, click the arrow  above the button and select the device you want to record from.

off            on
Volume levels
Use the sliders to the left of the System Audio and Microphone buttons to adjust the volume of each source.

 
Step 3: Record the audio
Click REC when you're ready to begin recording.

To end the recording, press F10 or click Stop on the recording panel.
 
Step 4: Save audio file
When the recording is finished, the capture editor window will appear, where you can play the audio you've recorded.
 
1. Click Save As to open the exporting options.
 
2. To save just the audio from your recording, click the MP3 button at the top.
If you want to save to a different audio format, click More presets and find the audio format at the bottom of the Video and audio tab.



 

162

 
3. Click Save to turn your recording into an audio file.

Troubleshooting audio
My device is not available in the list.
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.
 
1. Try re-connecting the device.
 
2. If that didn't help, right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The
Sound settings window will open.
 
3. Look for your device in the list:
•  If the device is working correctly, it should be marked with a green checkmark.
•  If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show
Disconnected Devices are selected.
•  If you still cannot find the device, download a driver for this device from the manufacturer's website and install it. This should help your system
detect the device.
 
4. Try enabling the device:
•  If the device is listed as Not Plugged In, try plugging in the device again.
•  If the device is listed as Disabled, right-click the device and choose Enable.
 
I can't enable system audio
If you're using Windows XP, system audio cannot be recorded simultaneously with microphone audio. To record system audio, open the list of
devices above the microphone button and choose Stereo Mix.

Making a video tutorial
Step 1: Launch the Screen Capture module
Open Movavi Video Suite and click Record computer screen on the Video tab to launch the screen capture module.

Step 2: Record your screen
1. In the Movavi Screen Capture window, click the Select Capture Area button and draw a rectangle over the area of the screen that you want to
record. Learn more
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2. Choose which audio you want to record: system audio to record sound you can hear from your speakers or microphone to record your voice.
Learn more
 
3. Set up mouse cursor highlighting in Preferences. This will help you bring attention to your actions on screen as you record the tutorial. Learn
more
 
4. Click REC to start recording. When you're done, click Stop to proceed.

Step 3: Add the video to the Editor
1. After you've captured your screen, click the Open in Editor button to open the captured clip in the Editor.
Editing captured files
 
2. In the Editor, click Add Media Files if you want to add more clips to your project.

Step 4: Cut the video
To cut the captured video, select the clip on the Timeline, place the position marker where you want to cut the clip, and click the scissors button
on the toolbar. Cutting video

Step 5: (Optional) Record and edit audio
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To record an audio voice-over:
 
1. On the Timeline, place the position marker to where you want the audio to start.
 
2. Click the microphone button on the toolbar to open recording options.
 
3. Select your microphone under Audio device, set up the volume and click Start Recording. When you're done, click Stop Recording, and you
can find your voice-over as an audio clip on the Timeline.
Learn more about recording
Audio tracks

To manage the volume for any clip, select it on the Timeline and click the Clip Properties button to open the Tools tab. There, set the Volume
slider to the necessary level for this clip.
Learn more about volume levels
 
Step 6: (Optional) Record video from a webcam
Many video tutorials and webinars also have the author's webcam video in the corner. Adding your own webcam video is easy: first, record the
video and then insert it as an overlay.
 
1. In the Editor, click the Record Video button on the Import tab.
 
2. The video recording module will open.  There, choose your webcam under Video capture device, choose a microphone under Audio capture
device, and then click Start Capture.
 
3. When you're done recording, click Stop Capture, and then Back to editing to add the video you've just recorded to the Timeline.
Learn more about recording video

4. The recording will appear at the end of the video track of the Timeline. To create an overlay, select the webcam clip and drag it up, towards the
top of the Timeline and place it onto the overlay track. The video will now appear in a small part of the frame over the main video track.
 
5. To change the overlay placement, double-click the overlay clip. Now, you can move and resize the overlay in the player. Click Apply on the
options panel above the player to accept the changes. Now you have both your captured screen and webcam in the same video.
Learn more about overlays
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Step 7: (Optional) Highlight objects
In addition to highlighting the mouse cursor, you can bring attention to parts of the screen using the zoom and highlight tools.
 
1. If you have a long recording but you only want to zoom or highlight a part of its length, cut this part into a separate clip and select it. Cutting
clips
 
2. To create a camera movement effect, click the Pan and Zoom button on the left sidebar. Choose a zooming mode, click Add, then set up the
zoom level and position using the frames in the player.
* If you don't see the Pan and Zoom button on the left sidebar, click the More button at the bottom of the sidebar and choose Pan and Zoom
from the list. This is also where you can find the Highlight and Conceal tool.
Learn more about Pan and Zoom
 
3. To highlight a part of the screen, click the Highlight and Conceal button the left sidebar. Choose Highlight mode in the Tools panel, then use
the frame in the player to select the area you want to highlight, and click Apply.
Learn more about Highlight and Conceal

Step 8: Export the video
Now that you're done with your tutorial it's time to save it in a format that everyone can enjoy.
 
1. Click the Export button to open the exporting options.
 
2. In the Export window, select a video format that you want to use and choose a folder to save the video to.
 
3. Click Start to begin exporting the video. This may take a few minutes.
Learn more about exporting
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Setting up a screen recording
Recording panel
You can use the recording panel to set up your recording.

Learn more: Capture area
 
Sound
You can record sound from two different sources on your video: from your speakers, or from an external device, such as a microphone.
•  Click the speaker button to record system audio,
•  Click the microphone button to record from a microphone.
Learn more: Sound
 
Webcam
You can simultaneously record your webcam footage that will show up in the corner of the video. Connect the camera and click the Webcam
button on the recording panel.
Learn more: Webcam

 
 
Cursor recording
If you're making an instructional video, you can highlight the cursor and its clicks to help your viewers keep track of your mouse. You can change
the appearance of your cursor in the Effects section of the Preferences.
Learn more: Mouse cursor effects

Keystroke recording
If you're showing keyboard actions such as hotkeys on your video, you can enable keystroke recording, and the keys you press will automatically
appear at the bottom of the video. You can enable keystroke recording in the Effects section of the Preferences.
Learn more: Recording keystrokes
 
Scheduling recordings
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When you've finished setting up your recording, you can start it right away or schedule it to begin or end automatically. You can schedule your
recordings in the Capture Time section of the Preferences.
 
Starting the recording
To start recording right away, click the REC button on the recording panel. You can pause and end capture using the buttons on the recording
panel: 
Learn more: Starting the recording

Capture area
The orange frame defines which part of your screen will be visible in your screen recording.
 
Selecting the capture area
Step 1: Click the Select Capture Area button on the recording panel.

Step 2: Your cursor will turn into a crosshair. Use it to select the part of the screen that you want to record.
 
•  To record a window or a window panel, hold your mouse pointer over the window you want to record and click when a frame appears around it.
Tip:  if you select a window, the capture area will follow whenever you move the window.
 
•  To record the entire screen, click on an empty part of the desktop, or
 
•  To record a part of the screen, click and drag diagonally to draw the area where you want it to appear.

Setting an exact size
After you've opened the recording panel, you can choose a preset size from the Capture Area section, or enter an exact size into the boxes:

To set the capture area to full screen, open the preset list and choose DISPLAY from the list.
 
Editing the capture area
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•  To change the capture area size, drag the edge of the capture area with your mouse.
 
•  To move the capture area, drag the square  in its center.

Sound
You can record sound from two separate sources: system audio and microphone audio. You can enable sound recording on the recording panel.

System audio
System audio is the sound that you can hear from your speakers. It includes music, video sound, alerts, and all other sounds.
 
1. To enable recording system audio, click the speaker icon on the recording panel. 

2. Use the slider to the left of the speaker button to change the system audio volume. This will also affect the volume that you hear. 
 
Microphone audio
To record from a microphone or any other external recording device:
 
1. Connect the microphone to the computer. Make sure that it is recognized by the system and working correctly.
 
2. Click the microphone icon on the recording panel to enable microphone recording.
 
3. If you have more than one recording device connected, click the arrow  next to Microphone and choose which microphone you want to use.
 
4. Use the slider to the left of the microphone button to change the volume.
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When enabled, the sound icons appear green. 

off            on
 
 
 

 

Troubleshooting
Capturing system sound on Windows XP
Windows XP does not support recording from multiple audio sources. You can either record microphone audio or system audio, but not both. To
record system sound on Windows XP:
1. Click the microphone button to enable recording from audio devices.
2. Click the triangle next to Microphone and choose Stereo Mix from the list of devices.
 
Please note that not all hardware allows stereo mix recording. 
 
See also:
Recording only audio
Recording Skype calls

Webcam
You can record webcam video simultaneously with a screencast. The webcam video will appear in the corner of the main video.
 
Enable the webcam
To enable webcam recording, click the webcam icon on the recording panel:  

Webcam options
If this is your first time recording with a webcam, you may want to set up how the webcam looks on your video. To open the webcam options,
click the cogwheel icon on the webcam button.
Or open the Settings menu, choose Preferences, and then switch to the the Webcam tab.

If you have more than one camera, choose the one you want to use under "Use this webcam".
 
Webcam properties
Click the Properties button to open your webcam's built-in properties. These can be different for each manufacturer, but usually you can set up
the brightness, white balance, exposure, and other color options.
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Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in
quality.
 
Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best
for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30
frames per second.
 
 
Video size
Use the video size slider to change the size of the webcam video relative to the main video.
 
Position
You can place your webcam footage in any of the four corners of the main video. Choose where to place the webcam video under position.
 
See also: Webcam preferences

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.
 
Step 1: Open the mouse cursor options
1. Click the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Effects tab.
Learn more: Effects options

Step 2: Enable the cursor
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

Step 3: Highlight cursor actions (optional) 
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.
 
Highlight cursor 
A semi-transparent circle will appear around the cursor, making it easier to track.
 
1. Select the Highlight cursor option.
 
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
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3. (optional) Use the Size slider to make the highlight smaller or larger. The cursor itself will remain the standard size.
 
Hover your mouse over the square on the right to preview the highlight.

Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons. 
 
1. Select the Highlight clicks option.
 
2. (optional) Click the left square to set the color for the left mouse button.
 
3. (optional) Click the right square to set the color for the right mouse button. 

Mouse click sound
A clicking sound will play whenever you click the mouse.
 
1. Enable the Mouse click sound option.
 
2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and
choose Add sound. Then, open the sound file that you want to use.
You can use WAV, MP3, AIFF, and AU files.
 

Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to
show the keys you pressed at the bottom of the video.
 
1. Open the Settings menu.
 
2. Choose Preferences.
 
3. In the Preferences window, switch to the Effects tab.
 
4. To enable keystroke recording, select one of the options:

•  Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do
not cause an action will not be displayed. 
•  All keystrokes — each key you press will appear on screen, including letters and numbers.
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To turn off keystroke recording, open the Effects preferences once again and select Do not capture keystrokes. 

Tips:
•  Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video,
your viewers will be able to see each character you type.
•  Keyboard shortcut recording does not work with the Windows key.

Scheduling
Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.
 
Step 1: Set up your recording 
Scheduled recordings will start with the currently selected capture area, sound, and other options. Before scheduling the recording:
 
1. Click the Select Capture Area button on the recording panel or Record screen on the launcher and select the part of the screen you want to
see on your scheduled recording.
 
2. To enable system sound recording, click the speaker button on the recording panel and make sure it is enabled and highlighted green.

Learn more: Capture area | Sound | Webcam
 
Step 2: Schedule recording
1. Open the Settings menu and choose Preferences.
 
2. In the Preferences window, switch to the Capture Time tab.
 
3. Under "Capture time options" select Start and end on schedule.
 
4. Next to Start time, enter the time and date when you want to start the recording.
 
5. Next to End after, enter the length of the recording.
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The recording is now set to automatically start and end at the given time.
 
Step 3: Schedule sleep or shut down (optional)
After a scheduled recording, you can set your computer to automatically sleep or shut down to conserve energy.
 
1. In the Capture Time preferences, open the After capture box.
 
2. Select Sleep or Shut down.

Step 4: Enable launching at startup (optional)
The screen recorder needs to be running at the scheduled start time to begin the recording. If you've scheduled the recording for a later date,
enable the program to start with your computer so that you don't miss the recording. To do that, open the General section of the Preferences and
enable the Launch application at startup option.
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Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in MKV format in
the output folder with your other screen recordings.

Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn more about
activating Movavi Screen Capture, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.

Time limit
When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is up.
This way, you don't have to wait around for the video to end.
 
Step 1: Set a time limit
1. Open the Settings menu and choose Preferences.
Or click the cogwheel button on the launcher to open the Settings menu.
 
2. In the Preferences window, switch to the Capture Time tab.
 
3. Select the Start manually and end after option.
 
4. On the right, enter the time limit as hours:minutes:seconds.
 
5. Click OK to enable the time limit.

Step 2: Start the recording
Click the REC button on the recording panel. After the specified time is up, the recording will end automatically.

 
Starting the recording

To begin recording:
To begin recording, do any of the following:
•  Click the REC button on the control panel.
•  Use the start recording keyboard shortcut (F10 by default)
•  In the system tray, right-click the Movavi Screen Capture icon  and choose Start Recording.
 
You will be given a 5-second countdown before recording begins.

The recording panel will change during capture:



 

175

On the left, you can see information about the recording:
Duration – the time recorded so far
Recorded – the recording size on disk
Left on Disk – how much free disk space you have left
 
In the middle, you can see which sound sources are being recorded and preview the webcam:

– Webcam off/on

 –System audio recording off/on

 –Microphone audio recording off/on
 
To pause recording:
To pause recording, do any of the following:
•  Click the Pause button on the recording panel.

•  Click the Pause button on the orange panel at the top of the capture frame: 
•  Use the pause capture keyboard shortcut (F9 by default)
•  In the system tray, right-click the Movavi Screen Capture icon  and choose Pause.
 
When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.
 
To stop recording:
When you're ready to finish the recording, do any of the following:
•  Click the Stop button on the control panel.

•  Click the Stop button on the orange panel at the top of the capture frame: 
•  Use the stop recording keyboard shortcut (F10 by default)
•  In the system tray, right-click on the Movavi Screen Capture icon  and choose Stop Recording.
 
The recording will end and the player window will open, where you can view and edit the video.
 
To cancel the recording:
If you want to terminate the recording without saving the video and delete the recording file, click Cancel on the recording panel.

Troubleshooting:
Windows style changes when I start recording
If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources and your computer
will run faster during capture. The Aero theme will return once you have finished capture. To disable this, open the Preferences and turn off the
'Disable Aero theme during capture' option in Video preferences.
 
Capture doesn't start immediately
By default, you will see a five-second countdown after you press the REC button and before the recording begins. You can use this time to
prepare for recording. If you want the recording to start immediately, open the Preferences and disable the 'Show countdown' option.
 
An orange panel appears on my recording
During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording, and keep track of the
recording process. If you don't want this panel to appear on your videos, open the Preferences and disable the 'Show capture control panel
during recording' option.

Editing captured files
When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and edit videos.
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Here's what you can do:
Cut recordings – trim videos from the beginning or the end, cut out fragments.
Change recording format – save the video in a different video format, as an audio file, or even as an animated GIF.
Compress videos – trade off some of the quality for a smaller file size.
Publish online – upload the video straight to YouTube.
View previous recordings – all your earlier recordings and screenshots in one place on the history panel.
 

Cutting recordings
This guide will show you how to cut out parts from video recordings using the built-in capture editor.
 
Step 1: Cut fragments
1. Move the position marker to where you want to cut the video.
 
2. Click the scissors button. A cut marker will appear at the current position.
 
Repeat these two steps to cut at the beginning and and at the end of each fragment you want to delete.

Precise positioning
For more precise positioning, click on the cut marker on the seek bar and do any of the following:
•  Click the previous frame and next frame buttons to move the cut marker by exactly one frame,
•  Click the arrows next to the time to move the marker by a small interval.
•  With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.
•  Manually enter the necessary time.
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Step 2: Delete fragments
1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.
 
2. To delete the selected fragment, click the trash can button.
 

A dotted line will appear on the seek bar where a fragment has been deleted: 

How to undo cutting
To cancel a cutting action, click Undo at the top of the window or press Ctrl+Z. To repeat a cancelled action, click Redo. 
 
Step 3: Save the edited video
If you've cut the video, you need to save it to apply the changes.
 
1. Click Save As. The window with saving options will appear.
 
2. At the top of the window, choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at
no quality loss.
 
3. Choose where to save the file and enter a file name.
 
4. Click Save to start processing the video. This may take a while for longer videos.
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Opening previous recordings
After you've finished a recording, it will open in the capture editor, where you can view and cut the file. If you want to edit the recording later, you
can open a recording file using any of the following:
 
Recent recordings
At the bottom of the capture editor, you can see a carousel of your previous recordings and screenshots. If you can't see the thumbnails, click the
Recent button in the bottom left to show the panel.
Tip: If you've changed the recording folder in File preferences, the Recent panel will only show recordings in the new folder.

Open a file
•  Find the file you want to edit in the Explorer and drag it onto the capture editor window. 
•  Or open the Capture menu and choose Open Recording File. Then, find the file in the Explorer dialog box and click Open.
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Storage location
The default locations for saving output files are:

•  "\Videos\Movavi Screen Capture\" – for video recordings
•  "\Videos\Movavi Screen Capture\Screenshots" – for screenshots

 
To change where the files are stored:
1. Open the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Files tab.

3. To change the video storage folder, click the ellipsis button  next to Save output videos to and choose a new folder.

    To change the screenshot storage folder, click the ellipsis button  next to Save screenshots to and choose a new folder.
4. Click OK to accept the changes.

Changing the format
New recordings are created in the MKV format which is supported by most players. This guide will show you how to save your video recordings in
a different format.
 

 Turn any video into an audio recording by saving it in an audio format.
 Easily watch videos on device if you save them to a device-ready format.

 
Step 1: Open the output options
Click Save As to open the output options.

Step 2: Choose a new format
At the top of the output options window, select a format you want to use.
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If you don't see the necessary format in the list:
1. Click More presets to open the full list of formats and presets.
2. At the top of the list, click the Video and audio tab.
3. Under General Video, choose the format you want to use.
Tip: you can use the search bar at the bottom of the list to find the necessary format.

 
Step 3: Name and location
Enter a name for your new file under File name. If you want to store the recording somewhere other than the default folder, click the ellipsis

button  next to Save to and choose a different folder.  
 
Step 4: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.
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Reducing output size

Long recordings with a large capture area size may take up a lot of disk space. In the capture editor, you can compress the video to a smaller file
size by trading off some of the quality.
 
Step 1: Open the output options
Click Save As in the bottom right-hand corner of the capture editor.  

Step 2: Set up compression
1. In the output options window, click the File size information.

2.  Use the Quality slider to change the output quality and reduce size:
•  Watch the bitrate and quality right above the slider. As long as the quality is High or Best, you most likely won't notice any difference.
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•  If you need a specific size, you can enter it into the Size box. The quality will change to accomodate this size. Check the quality above to make
sure you haven't set it too low.

What is bitrate?
Bitrate is the amount of data in each second of the video. The higher the bitrate, the more detail you can see. Bitrate is also affected by the
resolution, so if the file is still too large you may want to use a smaller capture area or convert the file to a lower resolution.

 
Step 3: Save the video
1. Under File name, name your new file.
2. To change the output folder, click the ellipsis button under Save to and choose a new folder.
3. Click Save to start processing the compressed video.

Publishing videos online
Once your video is ready, you can share it to YouTube!

  
Step 1: Open the Export window
Click the Share button at the top and choose YouTube to open the sharing options.
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Or click Save As to open the saving settings, click the Share to button and choose YouTube to open the sharing window. This way, you can
change the format or bitrate before uploading the video.

Step 2: Sign in to your account
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Capture upload videos.

Step 3: Choose a resolution
In the export window, open the Resolution list and choose a resolution that suits your video.
•  For best results, choose a resolution that is equal to or less than the height of your video. For example, if your video is 1280x720, choose the
720p resolution.
•  This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the website.
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Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – only you can see the video.
•  Unlisted – the video will not appear for other people unless you give them the link.
•  Public – anyone can access the video.

Step 5: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify
your account.
YouTube help – increasing your upload limit 
3. Click Start to begin saving and uploading the video.

Using the Video Editor
After you've captured your screen, you can immediately send the video to Movavi Video Editor. To do that, click the Open in Editor button at the
top of the player window:

https://support.google.com/youtube/answer/71673?hl=en
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Movavi Video Editor will open, and the video will be placed on the Timeline.

See also:
Cutting video in the Editor
Editing tools
Saving video in the Editor

Saving screenshots
You can save snapshots of any area of your screen, including videos playing in various media players.
 
Taking screenshots before capture:
1. Set up the capture area to include the part of your screen you want to take a snapshot of, or click the list of standard resolutions and
choose a variant you need. For more information, please see the Capture Area section.

2. Take a screenshot:
•   Select Take a Screenshot in the Capture menu...
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•   Or use screenshot shortcut key (F8 by default). You can
change it to a custom key or key combination in preferences.

3. In screenshot saving window, choose a destination folder for screenshots, choose suitable file type from Files of type list
and finally click Save.
 

Taking screenshots during capture:
•   Select Take a Screenshot in the Capture menu...
•  Or use screenshot shortcut (F8 by default). You can change it to a custom key or key combination in preferences.
 
After
capturing
video,
you
will
see
the
screenshots
taken
during
capturing
at
the
bottom
of
the
saving
window
in
the
Recent
panel.
 
The
screenshot
destination
folder
can
be
changed
in
preferences.

Tip: if the main window is visible inside the orange capture area during capture (for instance, when
you capture fullscreen on a one-monitor personal computer), it will be visible on screenshots as well.

It is recommended to minimize the main window during capture and use shortcut keys for taking screenshots.

Screen Capture preferences
 
To open the program settings for Movavi Screen Capture, open the Settings menu and select Preferences.
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The preferences are organized into eight categories: General, Files, Keyboard Shortcuts, Video, Webcam, Effects, Capture Time and Sharing.
 

General preferences
The General tab allows you to change the basic behavior of the program.

 
 Disable countdown

Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this option to
turn the countdown off and start recording immediately.
 

 Show capture control panel during recording
The capture control panel will appear on top of the capture frame while recording a video. You can use it to pause or stop capture, take a
snapshot, or see how much space the recording has taken up. If you are recording a full screen video, the panel will not be visible.
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 Capture separate streams
When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers.
This can be useful for editing the video in the Video Editor later, so you can edit them separately.
 

 Sound notifications
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.
 

 Launch application at startup
With this option enabled, Movavi Video Suite will start when you log in and run in the background. This way you will always be ready to capture
your screen.
 

 Use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics
cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software
replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 

 Automatically check for updates
The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates
users with purchased Movavi Video Suite license will get a considerable discount.
 

 Send anonymous usage stats to Movavi
Enabling this box will allow Movavi Video Suite to send us anonymous data about how you use the program. This data does not contain any
personally identifiable information and is only used for improving our software. You can find more information about how we use the statistics on
our Movavi Improvement Program page.

 
File preferences

In the Filessection of the preferences, you can change where your captured files are stored. To change a folder location, click the icon with the

dots and select a new folder: 

Save output videos to...
This is where all your video recordings are saved.
 

http://www.movavi.com/mip.html


 

189

Delete original recording after saving
If you save the recording in a different format, or trim the file, the original will be deleted.
 
Save screenshots to...
This is where all your new screenshots are saved. You can also find your recent screenshots in the editor window.
 
Default screenshot format
Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button in
the editor window to save a copy with a different format.

 
Keyboard shortcuts

The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On the
right, you can see keyboard shortcuts for every action.

To change one of the shortcuts:
 
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom
shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.
 
In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

Video preferences
On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate, number
of channels, and bits per second.

Frame rate
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The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame rate
will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.
 
Output frame size
Usually, your desktop is recorded at full size. This option allows you to reduce the original video quality to 1/2 or 1/4 of the original. The video file
will have lower quality, but take up less disk space. This can also improve performance while recording on slower computers.
 
Sample rate
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record sound.
Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human hearing range.
 
Channels
Mono uses only one audio channel, which saves some disk space.
Stereo uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

 
Bit depth
Screen Capture will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample contains 16
bits of information to encode sound.
 
Enable SuperSpeed conversion
This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the format.

Formats that work with SuperSpeed are marked with these icons:  or  in the list. If you're having problems with saving some files, try
disabling this option.
 
Enable Intel hardware acceleration
This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works when
processing H.264, MP4, and MPEG-2 videos.
 
Enable NVIDIA GPU acceleration
This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and
improves performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC® or
CUDA® technologies.  
 
Disable Aero theme during capture
Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video. With
this option enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after recording
has finished.
(For Windows Vista and Windows 7)
 
Use DirectX for capturing
Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen
automatically and this option is unavailable.
(For Windows 7 and earlier)
 
Use alternative capture mode (not recommended)
If you get an error message  when you start or stop recording your screen, try this option. If the problem isn't solved, click here to read full
troubleshooting instructions.
(For Windows 8 and above)

Webcam preferences
The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video. 

Enabling the webcam

http://kb.movavi.com/article.php?id=290
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1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.
 
If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the
right to check that the camera is working properly.
 
Webcam properties
Clicking the Properties button will open the camera's properties. These properties are different for each manufacturer, but generally you can use
them to calibrate the brightness, contrast, and exposure of your camera.
 
Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in
quality.
 
Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best
for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30
frames per second.
 
Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.
 
Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.
 

Effects
In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.

Cursor options
Select Show cursor on recording to make the cursor visible to your viewers.
 
Highlight cursor
This option will add a bright circle around the mouse cursor to make it more visible.
1. Select the Highlight cursor option.
2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.
Hint: hover your mouse over the preview square on the right to see how it will look on the recording.
 
Highlight clicks
This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
1. Enable the Highlight clicks option.
2. Click the left square to set the color for the left mouse button.
3. Click the right square to set the color for the right mouse button.
 
Mouse click sound
A clicking sound will be played every time you click the mouse to draw attention to your actions.
1. Enable the Mouse click sound option. The default mouse click sound will be used.
2. (optional) If you have a file with a different sound effect you want to use, open the box under 'Mouse click sound' and choose Add sound.
Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.
 
Keystroke recording options
•  Keyboard shortcuts only – only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
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•  All keystrokes – all key presses, including letters of the alphabet, will appear on the video.
Hint: avoid entering passwords when this option is enabled if you don't want everyone to see your password.

Capture time
In the Capture Time section of the preferences, you can start and stop recordings automatically.

Automatically ending a recording
1. Select the "Start manually and end after" option.
2. Enter the duration of the recording into the box on the right (hours: minutes: seconds).
 
Scheduling a recording
To start and end a recording automatically:
1. Select the "Start and end on schedule" option:
2. Next to "Start time", enter the time and date when the recording should start.
3. Next to "End after", enter the duration of the recording (hours: minutes: seconds).
 
The Screen Capture application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch
application at startup" option in the General section.
 
After capture
If you've scheduled a recording, you can tell your computer to automatically sleep or shut down after the recording is finished. The recording file
will be saved.
 
 
 

Sharing preferences
The Sharing tab allows you to manage your YouTube accounts used to upload videos to.
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To sign in to your YouTube account:
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Capture upload videos.

Capture video
Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
 
Step 2: Open the Movavi Video Suite launcher window and click Capture from cameras, VHS, TV on the Video tab.

 
Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A larger
resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while
static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

Step 5: (optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button  under 'Save files to' and choose a different location.
 
Step 6: (optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
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Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.

Import AVCHD
Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that the
system recognizes the device and that it is working correctly.
 
Step 2: Open the Movavi Video Suite launcher window and click Import AVCHD on the Data tab.
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Step 3: In the Video capture device box, select your AVCHD camera.

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name
template. 
 
Step 7: Click Export files to start copying the files. This may take a while depending on the size of the videos.
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Capture audio
Step 1: Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.
 
Step 2: Open the audio recording module
Open the Movavi Video Suite launcher and click Record sound. The audio recording module will open in a separate window.

Step 3: Set up audio capture
In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To record audio that is
playing on your computer*, choose 'Stereo Mix' or 'Speakers'.
* Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not include a system audio
recording option.
 
In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File renaming box and
choose date or free text. Then, fill in the template details and the recordings will all be named after this template.
 
Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse for the folder you
need.



 

197

Step 4: Record
Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the center. When you're done,
click Stop Capture. If you need to record more audio clips, simply repeat this step.
 
The audio files will be saved to the folder specified in the 'Save files to' box. To open this folder, click the View saved files button. 

Split video
Split Movie is a lightweight program for quick video editing. With it, you can cut a video file into small scenes or cut out any number of unwanted
parts like commercials. To open the video splitter, click Split video on the Video tab of the Movavi Video Suite launcher.

Step 1: Open a video
To open a video file, simply drag it onto the Split Movie window.

Learn more: Open videos
 

Step 2: Edit the file
Use the Scissors button to cut the video into scenes, then select the scenes you want to remove and click the trash can button.
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Learn more: Trim from the edges | Split scenes | Cut out parts
 

Step 3: Save the result
In the bottom right-hand corner, choose As separate files to save each scene to its own file, or choose As a single file to save

the entire video minus the deleted scenes to one file. Then, click Save and select where you'd like to place the new file(s).
Learn more: Saving the result

How to split video
The splitting module allows you to quickly split a video file into parts or cut out fragments without reconverting the file or any quality loss.
 
Launch the splitter
In the Movavi Video Suite launcher, click Split video on the Video tab.

Open files
To start cutting videos, click Open file in the middle of the window and choose a video file.
Learn more: Opening files

Split scenes
To cut the video into several scenes, place the position marker where you want to cut scenes and click the scissors  button. Repeat this for all
scenes in the video.
Learn more: Splitting scenes
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Cut out unwanted fragments
To remove a fragment from the video, place the position marker onto the beginning of the fragment and click the scissors  button. Then, do

the same for the end of the fragment. When the fragment is separated, select it and click the trash can  button to remove it.
Learn more: Cutting out parts

Save the result
In the bottom right-hand corner, you can choose how to save the resulting clips:
•  To save each scene as a separate file, select As separate files.
•  To save all scenes to a single file without the deleted fragments, select As a single file.
Then, click Save to start processing the video.
Learn more: Saving the result

Opening files
To open videos, do any of the following:
•  Find a file in Explorer and drag it onto the Movavi Split Movie window.
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•  Click Open file in the center of the window and choose the file.
•  Open the File menu and choose Open File. Then, choose the file you want to cut.

 
 
 

Playback
After you've opened the video, you can use the playback tools to find where you need to cut the video.
 
How to position the playback marker:
•  When you play the video, press the spacebar to stop the video when you see a scene border.
•  Use the Previous frame / Next frame buttons on the toolbar to move the position marker by one frame.
•  Use the timeline scale above the seek bar for reference.

Jumping to a specific time:
1. Open the Playback menu and choose Jump To.
2. Enter the exact time and click OK.
The position marker will move to the specified time.  

Cut out parts
Follow these steps to cut out an unwanted fragment from the video:
 
Step 1: Move the position marker to the beginning of the unwanted fragment.
 
Step 2: Click the scissors button.
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Step 3: Move the position marker to the end of the unwanted fragment.
 
Step 4: Click the scissors button again. The fragment is now separated from the rest of the video.

Step 5: Click the fragment you've cut to select it and click the trash can button to reject it.

Repeat these steps for all other unwanted fragments in the video. After you're done, don't forget to save the result.
 
See also:
Opening files
Saving the result

Liking a scene
You can quickly mark fragments as you play back the video.
 
Like a fragment – Press L to play the video and keep the fragments you pass.
 
Dislike a fragment – Press K to play the video and reject the fragments you pass. 

You can change these keys in the Keyboard Shortcuts window.
Using the brackets

Using the bracket buttons, you can mark the beginning and end of each scene. Using the brackets works best if you only need to keep a small
part of the video.

 The Left Bracket marks the beginning of a clip, rejecting the parts before it.

 The Right Bracket marks the end of a clip, rejecting the parts after it.
 
 

Trimming from the ends
To trim the video from the beginning or from the end, click on the seek bar and pull on the markers on the edges:
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Splitting clips
Step 1: Move the position marker to the beginning or the end of a fragment.
 
Step 2: Click the scissors button to make a cut.
 
Repeat this for other fragments that you want to cut into separate files. After you're done, don't forget to save the result.

See also:
Opening files
Saving the result

Editing clips
After you've cut the video into clips, you can edit each clip for more precise splitting.
 
Editing clips
To change the left and right borders of a clip, do any of the following:
•  Click on a clip and drag the white markers on its edges to change its length.
•  Click on a marker and press the left or right arrow keys to move it by exactly one frame.
•  To move a clip, select it and drag it by the center.

Setting exact time
In the Resulting clips column on the right, the exact beginning and end time is listed for each clip. Click the time and manually enter the new time
into the box.

Discarding clips
To discard an entire clip, select it on the Timeline on in the Resulting clips column and click the trash can button.

Merging clips
To merge two or more clips into one contiguous clip:
1. Select the clips you want to merge on the Timeline or in the Resulting clips column. Hold Ctrl to select multiple clips.
2. Right-click on the clips and select Merge from the pop-up menu. All of the selected clips (as well as any rejected fragments between them) will
be marked as one single clip.
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Inverting clip selection
Open the Edit menu and select Invert clips in the pop-up menu. This will invert the selection for the entire file, meaning that previously rejected
fragments will be saved, and selected parts will be rejected.

Resetting clip selection
If you want to start over, click the Reset button on the toolbar or right-click in the Resulting clips section and select Delete All.

Saving the result
After you've split the scenes and removed unwanted fragments, you'll need to save the resulting clips. The saving options are located in the
bottom right-hand corner of the window.
 
Step 1: Select how you want to save the file
•  If you want to cut the video into several files, select As separate files.
•  If you want to save the video as a single file without the rejected parts, select As a single file.
 
Step 2: Click Save.

Step 3: You may be asked to choose a folder for saving the video. Click the folder icon  in the dialog box to change the folder. Click OK to start
saving the resulting clips.
Hint: If you want to keep using this folder, choose Always save to this folder without asking. You can always change this option on the Saving
tab of the Preferences.

Keyboard shortcuts
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For faster editing, the most commonly used actions are bound to shortcuts or hotkeys.
 
To open the list of shortcuts:
1. Open the Settings menu.
2. Select Keyboard Shortcuts.
 
To change a shortcut:
1. Double-click the field next to the action you want.
2. Press the key or key combination you want to use.
 
Note that some key combinations may not work because if they are used by your system.

List of keyboard shortcuts
 
 

Splitter preferences
To open preferences, go to the Settings menu. The options are sorted into two tabs at the top.
 
General
Language – Changes the interface language.
 
Automatically check for updates – Whenever a new version is available, you will be notified when you start the program.
 
Send anonymous usage stats to Movavi – Lets the program collect statistics about how you use the program. The data does not contain
any personally identifiable information and is only used for improving our software. You can find more information about how we use the
statistics on our Movavi Improvement Program page.
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you see
an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics
cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software
replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If Movavi Split Movie runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

Saving

http://www.movavi.com/mip.html
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Destination folder – this is where the resulting files will be saved by default. To change the location, click the folder icon  on the right.
 
Always save to this folder without asking – if this option is disabled, you will be prompted to choose a folder every time you save videos.
 
Play notification sound when splitting is finished – a sound will play when the resulting clips have been saved.

 
Play video and audio

With the Movavi Video Suite player, you can play video and audio in any format without having to install any additional codecs or software. To
open the player, click Watch video in Movavi Video Suite launcher on the Video tab.

 
Or click Play music on the Audio tab.

Opening files
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To open video or audio files, click the buttons in the bottom right, under the playlist.
+ File to open individual files
+ Folder to open all the files in a folder
+ DVD to select a disc with videos. You will need to find the VIDEO_TS folder on the disc.
 
Or you can simply drag any files you want to play right onto the player window.

Playback
Basic playback buttons

Skipping frames

On the toolbar, click Skip forward  or Skip backward  buttons to skip 10 seconds forward or backward.
 
Playlist buttons
 
The playlist displays your media queue. If you want to jump to another item, double-click it in the playlist to play.

To show or hide the playlist, click the List button  on the toolbar.

To play all items in random order, click the Shuffle button .

To play the same item again and again, click the Repeat button .
 
 
 

Adjust video
In Movavi Video Suite, you can adjust brightness, contrast, hue and saturation of the video.
 
Step 1: Open Video Adjustments dialog box
Click the Adjust video button on the toolbar.

The Adjust video button
Step 2: Adjust video
Hold your mouse on the markers and drag them left or right, depending on the changes you want to make. Release the markers to see how your
video has changed.
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If you are satisfied with the results, click Apply to save your settings.
Change audio track

In Movavi Video Suite, when you watch a video with two or more audio tracks, you can easily switch between them.
 
In the menu, click Audio and select Audio Track in the pop-up menu. A list of available audio tracks will appear. Select the one you need. You will
hear it immediately.

Subtitles
Changing subtitles track
In the menu, click Subtitles and select Subtitle Track in the pop-up menu. A list of available subtitle tracks will appear. Select the one you need.
You will see it on screen immediately.

To load subtitles from a file, select Add Subtitle File on the list.
 

Subtitle timing
You can adjust your subtitle timing in case you notice it's off track. In the menu, click Subtitles and select Synchronize Subtitles in the pop-up
menu. A list of options will appear. Select the one you need. (For example, clicking +5 seconds will make subtitles appear on screen 5 seconds
later than before).

Subtitles positioning
To move subtitles, click Subtitles in the menu and select Align Subtitles in the pop-up menu. A list of positioning options will appear. To set
subtitles to a certain part of the screen, choose Top ... Right. Clicking Move up ... Move right will slightly move subtitles around the screen.
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Burn files to disk
With the Burn Disc application you can burn videos to DVDs, create audio CDs, copy discs and burn any kinds of data to a CD, DVD or Blu-ray.

How-to's:
Burn videos to DVD
Burn an audio CD
Burn data to disc

Burn ISO image to disc
Copy disc to disc

Rip disc to hard drive
 

Step 1: Add Files
1. In the Video tab of the Movavi Video Suite launcher, click Burn CD, DVD, Blu-ray to open the Burner module. The ChilIBurner module will open.
2. Drag and drop the files you want to burn from Windows Explorer onto the ChilIBurner window to add them to the disc queue.
 
Step 2: Choose Disk Type
1. In the Mode section on the right, choose the type of disc that you have. Disc type and capacity should be printed somewhere on the disk itself
or on its packaging.
2. Then, choose video options for the selected disc type.
 

NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.
•  NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan, the
Philippines, South Korea, Taiwan, and Vietnam.
•  PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina, Brazil,
Paraguay, Uruguay, and French Guiana

 
Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
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Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used for
widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on the
package your DVD came with).
 
DVD menu template – select a graphic DVD menu, which is the first thing you see when you open a disc on your player, and where you
can select which file to play. 

 

Step 3: Burn Disc
1. Check the disc capacity scale at the bottom. If the blue line crosses into the red, it means that there is not enough space to fit all of the added
files. In that case, you can either set a lower quality, or write some of the files to another disc.

Disc capacity scale
 

2. In the upper right-hand corner of the window, enter a name for the disc. It will show up in My Computer when you view all your drives.
3. Make sure that a writable disc of the selected type is inserted into the drive, and your hardware supports disc writing. 
4. Click Burn Disc to begin recording the files to disc. This may take a few minutes.

How to open the burning module
 
Burn audio:
In the Movavi Video Suite launcher, click Burn audio to CD on the Audio tab.
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Burn CD/DVD/Blu-ray video:
Click Burn disc on the Data tab.

Burn ISO to disk:
Click Burn image to disc on the Data tab.

Copy disk to disk:
Click Copy disk to disk on the Data tab.
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Copy disc to computer:
Click Copy disk to hard drive on the Data tab.

 
Burn a video DVD

Step 1: Open the Burn Disc application in Video mode
1. Click Burn disc on the Data tab of the Movavi Video Suite launcher app.
2. The Burn Disc application will open. There, click on the Video tab at the top.
 
Step 2: Choose your disc type
In the Mode section of the right-hand column, choose DVD mode.
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Step 3: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
 
 
Step 4: Set up your disc preferences
Set the following preferences in the right-hand part of the window:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer or
DVD player.
NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.
•  NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan, the Philippines,
South Korea, Taiwan, and Vietnam.
•  PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina, Brazil, Paraguay,
Uruguay, and French Guiana
 
Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used for
widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on the package
your DVD came with).
DVD menu template – the DVD menu is the first thing you see when you open a disc on your player, and where you can select which file to play.
The ChilIBurner module allows you to select and customize professional-looking DVD menus. By default, only one theme will be available, but you
can select Download More Themes from the list and download additional themes from our official website. If you want to customize or preview
the selected theme, click Edit. You will see the following window:
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Here, you can set the time for the previews of each video and change the music that will play in the menu. Click OK to apply the changes.
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you record the
videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality.
Then, check that you have a writable DVD in your DVD drive and click the Burn Disc button to begin the burning process. Your disc will be ready in
a few minutes.

 
Burn an audio CD

Step 1: Open the Burn Disc application in Audio mode
Click Burn audio to CD on the Audio tab of the Movavi Video Suite launcher app.
 
Step 2: Choose audio disc type
In the Mode section of the right-hand column, choose Audio CD or MP3 CD mode. Standard audio CDs usually fit about an album's length of
music, but can retain quality very well, while MP3 CDs allow you to record several folders of audio files to one CD. Please note that not all CD
players support MP3.
 
Step 3: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
 
Step 4: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
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Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the disc into your computer or
Blu-ray player.
 
Disc type – select CD if you have a regular CD Disc, or Mini-CD if you have a CD of smaller size (8 cm or 3.1 inches in diameter versus the
standard 12 cm or 4.7 inch CDs).
 
Quality – if you select MP3 CD mode, you can set the quality of the audio files. Higher quality files have higher bitrate, but take up more space. If
you select Audio CD mode, the best quality will automatically be selected. 
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you record the
videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality for
MP3 files.
Then, check that you have a writable CD in your disc drive and click the Burn Disc button to begin the burning process. Your disc will be ready in a
few minutes.

Burn data to disc
Step 1: Open the Burn Disc application in Data mode
Open the Movavi Video Suite launcher application and click Burn disc on the Data tab.

 
Step 2: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
 
Step 3: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
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Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer or
DVD player.

 
Disc type – select the type of recordable disc that you have. Disc capacity is listed in parentheses. If you are not sure if you have a double-layer
(DL) DVD or Blu-ray™ disc, check the package that it came with. 
 
Step 4: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you record the
videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete some files from the list or, if you are recording
video and audio files, use the conversion module to compress them.
Then, check that you have a writable disc of the selected type in your drive and click the Burn Disc button to begin the burning process. Your disc
will be ready in a few minutes.

Please make sure your optical drive supports recording to the selected type of disc.
Burn ISO to disc

The Burn Disc module can help you burn disc images with the .iso extension to an optical disc.
 
Step 1: Open the Burn Disc application in Copy mode
1. Open the Movavi Video Suite launcher and click Burn image to disc on the Data tab.
2. In the Burn Disc application, open the Copy tab.

 
Step 2: Select the image
Click the Browse icon  next to the Source list to browse for the .iso file you want to burn.
In the Destination list, select the drive you want to use for recording. If you have only one DVD-RW drive, it will be selected automatically.
 
Step 3: Start burning
Check that you have a writable disc in the optical drive and click Burn Disc to begin burning your ISO file to disc.

Copy disc to disc
If you have two CD/DVD drives:
Step 1: Insert the discs
Insert the disc you want to copy into one of the drives. If only one of your CD/DVD drives can burn discs of this type, insert the disc into the read-
only drive (i.e. CD-R or DVD-R drive).
Then, insert a recordable disc into the other CD/DVD-RW drive. If you are using a CD/DVD-R disc, make sure that is hasn't already been recorded
to.
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-protected and cannot be copied or
ripped to hard drive.
 
Step 2: Open the Burn Disc application in Copy mode
Open the Movavi Video Suite launcher and click Copy disc to disc on the Data tab.
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Step 3: Set Source and Destination
In the Source list, select the drive with the disc you want to copy. If you cannot see the drive in the list, make sure that the CD/DVD you want to rip

is inserted into the drive and click the orange refresh icon  to its right.
In the Destination list, select the drive with the empty disc.
 
Step 4: Start copying
Click Burn Disc to begin copying data from one disc to another.

If you only have one CD/DVD-RW drive:
1. Save the contents of the disc as an ISO.
2. Burn the ISO file to disc.
 

Copy disc to hard drive
Step 1: Insert the disc
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-protected
and cannot be copied or ripped to hard drive.
 
Step 2: Open the Burn Disc module in Copy Disc mode
Open the Movavi Video Suite launcher application. In the Data tab, select Copy disc to hard drive. The Burn Disc module will open.
 
Step 3: Set Source and Destination
In the Source list, select your CD/DVD drive If you cannot see the drive in the list, make sure that the CD/DVD you want to rip is inserted into the

drive and click the orange refresh icon  to its right.
In the Destination list, select Browse folder and specify the location where you want to save the disc files.
 
Step 4: Start copying
Check that you have enough disc space to copy the disc and click Burn Disc to begin copying disc files to your hard drive.

 
Uploading files to the web

When you're done creating and editing your videos, surely, they deserve to be shared with your friends and maybe with the whole world! There are
several ways to upload your video.
 

Upload screen recordings to YouTube Upload Video Editor projects to YouTube

Learn more: Uploading videos online Learn more: Publishing videos online
 

How to upload files to YouTube, Facebook, Vk.com, Amazon S3, and FTP storage
 
With the free Share Online app, you can upload a whole batch of files to multiple destinations. To open the sharing app, click Share photos online
on the Photo tab of the Movavi Video Suite launcher.

If you haven't used the sharing app, you'll need to install it first. To do that, simply click Download in the message and the app will automatically
download and install in a few minutes.
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 From then on, you can use the Share photos online button to open the sharing app.

Next on sharing:
Open files
Upload videos to YouTube
Upload files to Facebook
Upload files to Amazon S3 storage
Upload files to FTP
Upload photos
Manage your accounts

 
Adding media files

Before you begin uploading your videos and files online, you will need to add the files to the queue. If you used the Upload to the Web option
in one of the Movavi Video Suite modules to open Share Online, the files will already be added to the program, however you can always add
additional files using one of the following ways:
 
Step 1: Select the necessary files in a Windows Explorer window and drag them onto the Share Online window.

 
Step 2:. In the top part of the Share Online window, click Add File and browse for files you want to upload.

 
Step 3: If you want to add all files within a folder, click Add Folder at the top of the window and select one or more folders in the Browse dialog
box.

 

Managing files on the list:
•  To remove a file from the list, click the  button to the right of it.
•  If you want to temporarily exclude files from the upload queue, uncheck the box  to the left of the file. The file will remain in the list, but will not
be uploaded when you click the Upload button.
•  To remove all files from the list, click Clear List at the top of the window.

Uploading photos
Besides video and audio files, Movavi Video Suite can also help you upload photo albums.
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Step 1: Add files
1. In the Photo section of the Movavi Video Suite Launcher, click Share photos online to open the sharing module.

2. Drag-and-drop files from Windows Explorer onto the Share Online window or use the Add File and Add Folder buttons at the top of the
window, and specify the files you want to open.

Step 2: Choose upload destination
Using Share Online, you can upload your photos to several sites at once.
 
1. To select the services to which you want to upload your photos, click their icons at the bottom of the window.
* Note that YouTube does not accept photo uploads. Photos in the upload queue will still be uploaded to other selected services.
 
2. If you're using a service for the first time, you will be asked to authorize with the website. Don't worry, your login data is safe: where possible,
authentication is processed through the website itself, so that your user data is not seen or stored by Share Online.

Step 3: Add descriptions
Now you can add some additional information about each file.
1. Click a file in the list. File Information fields will appear in the column on the right.
2. Fill in the title and description for the file. At the bottom of the column, you will see service-specific fields, such as privacy options.
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Step 4: Upload the files
When you're ready, click the Upload button to begin sharing your photos. This may take up to a few minutes depending on your Internet
connection. 

Uploading videos to YouTube
Follow the instructions below to upload videos to YouTube. You will need access to a YouTube or Google account to upload the videos.
 
Step 1:
Click Share photos online on the Photo tab of the Movavi Video Suite launcher.

Step 2:
Add media files to the list or use the upload option in one of the Movavi Video Suite modules.
 
Step 3:
In the bottom part of the Share Online window, click the YouTube icon. You can also choose to upload to other services simultaneously by
clicking their icons.
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Step 4:
If you have not yet logged in, the program will ask for your login data*. Enter your YouTube username and password into the respective fields and
click OK.

Step 5:
In the file list, click on a file to select it. The right part of the window will display a number of fields. Here, you can fill in some information about
your video:
•  Add an eye-catching name and description that will be displayed on the video's page on YouTube.
•  Add a few tags describing the videos and select a relevant video category: this will help other users find your video.
•  Define privacy settings: public will mean that any YouTube user can find your video, while private videos can only be seen by your friends and
people that you send a link to. 
•  Check the length information. As per YouTube limitations, only verified accounts are allowed to upload videos longer than 15 minutes. For
details on verifying your account and increasing your upload limit, please see Google's official support page.
Repeat step for all files in the list.

Step 6:
When you're ready, click Upload to start uploading your files to the selected services. 

https://support.google.com/youtube/answer/71673?hl=en


 

221

*Your data will only be used for authentication with the selected services and never transferred to third parties.
Uploading videos to Facebook

You will need access to a Facebook account to upload videos and other content via the Share Online module.
 
Step 1: Add media files to the list or use an export option in one of Movavi Video Suite modules.
 
Step 2: In the bottom part of the window, click the Facebook icon. You can also select other services if you want to simultaneously upload files
to them.

Step 3: If you have not yet authenticated with Facebook, you will see a login window appear. Enter your Email and password and click Log In. If
you don't want to sign in every time, check Keep me logged in to Movavi Share Online.

Step 4: In the file list, click a file to select it. You will see some fields appear in the right pane. You can use these fields to add a name and
description, as well as assign a number of tags to make your video easier to find. Please check the length of each video, as Facebook does not
allow videos longer than 20 minutes. You can still split long videos into multiple files using the Split Movie or Video Editor module and upload
them together.
Repeat this for all your files.
 
Step 5: When you are ready, click Upload to begin uploading your files. Soon, they will appear on your Facebook page.

 
Uploading videos to Amazon S3

You can use the Share Online module to upload files to your Amazon S3 storage.
 
Step 1: Add files to the program or use an export option in another Movavi Video Suite module.
 
Step 2: In the Upload to panel at the bottom of the window, click the S3 icon to select Amazon S3 as the upload server. You can select more
than one upload destination.
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Step 3: If you have not yet provided your Amazon S3 credentials, you will be asked for them now. Enter the necessary information and click OK.

Step 4: (Optional) In the file list, click a file to select it. You will see some fields appear in the right side of the window. You can use the fields to
provide some information about the uploaded files. You will need to do this for each file separately.

Step 5: To begin sending the files to the server, click Upload.

Uploading videos to FTP
The Share Online module of Movavi Video Suite also supports FTP file uploads.
 
Step 1: Add your files to the list or export them for sharing online via another Movavi Video Suite application.
 
Step 2: In the bottom panel, click the FTP icon to select FTP as the upload service. You can also choose other services along with FTP to upload
files to them as well.
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Step 3: If you haven't yet entered your FTP server information in account preferences, you will be asked for it now.

Step 4: (Optional) Select a file in the file list. You will see its information appear on the right. Here, you can fill in more information about it and
specify a folder where you would like to upload the file. Repeat this for all other files.

Step 5: Click Upload, and your files will be sent to the FTP server. 

Accounts
To upload media files to a web site or a hosting service, you will need to provide your login credentials, such as a login and password, to allow
Share Online to upload the files on your behalf. Your account data is stored by Share Online so that you will not have to re-enter it the next time
you upload files to that service. The data is only used for authorization with the services you choose and is not sent to any other parties.
 
To view information about saved accounts:
1. In the upper right-hand corner of the Share Online window, click Preferences.
2. A Preferences window will open. Click the Accounts tab at the top.

 
Here, you can manage saved accounts, log in to services, and erase account data. You can check the username listed under a service to see
which account you are logged in as.
 



 

224

3. To clear saved account data, click the Disconnect button next to the service. Next time you select this service, you will be asked to authorize
again. You can also use the Disconnect button if you want to log in to a different account.

 
Help and support

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.
How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

Frequently asked questions:
How to remove trial restrictions?
Why do my videos have "trial version" on them
What are the system requirements for running Movavi Video Suite?
How to update the graphics card drivers?

System requirements
  Minimum system requirements Recommended configuration
Operating system Windows XP*/Vista/7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1.5 GHz Intel, AMD or compatible processor, 2.8 GHz and

above
Graphics card NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher graphics card with up-

to-date drivers**
Resolution 1024x768, 32-bit color 1280x1024 or higher
RAM Windows XP – 512 MB

Windows Vista, 7, 8, 10 – 1 GB
Windows XP – 1 GB
Windows Vista, 7,8, 10 – 2 GB

Available disk space 850 MB for installation
2 GB for ongoing operations***

10 GB

  Administrator permissions are required for installation
Additional features:   Sound card for audio recording and playback
    Intel® hardware acceleration requires a

compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher
Learn more

    For intended performance, make sure that your
graphics card drivers are up-to-date.
Updating graphics card drivers

 
* Windows XP does not support recording system sound simultaneously with audio devices.
** Your graphics card must support OpenGL for the program to run correctly.
*** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on the
resolution, format, and length of your videos.
 
 
Movavi Video Suite may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not
met.

Supported formats
 

 
Video formats Input Output

 
Supported codecs

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4
ASF (.asf)   MPEG-4, VC-1, WMV V7

mailto:support@movavi.com
https://www.movavi.com/support/contact.html
program_preferences.htm#video_preferences
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H.264, MPEG-4, MJPEGAVI (.avi)
  DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Uncompressed

DivX Video (.divx)   DivX

DVD  

FLV1, H.264
  VP6, H.263, Flash Screen Video

Flash (.flv, .swf)

  MJPEG
H.264, MPEG-4, MJPEG, Theora, VP9Matroska (.mkv)

  DV, Uncompressed
MPEG Transport Stream (.m2ts) MPEG-2, H.264
MPEG Transport Stream (.ts, .mts, .m2t)   MPEG-2, H.264
MPEG (.mpg, .vob) MPEG-1, MPEG-2
MPEG (.mpeg, .mpe, .m1v, .dat, .mod, .tod, .vro)   MPEG-1, MPEG-2, H.264

MPEG-4, H.264MPEG-4 (.mp4)
  H.263, MJPEG, ProRes

MPEG-4 (.m4v)   MPEG-4, H.264, H.263, MJPEG, ProRes
MXF – Material eXchange Format (.mxf)   MPEG-2, DV

TheoraOGV – Ogg Video (.ogv)
  MPEG-4

H.264, MPEG-4, MJPEGQuickTime (.mov)
  AIC, ProRes, Sorenson 1/3, PNG

QuickTime (.qt)   H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3
RM (.rm, .rmvb)   Real Video 2/3/4, Cooker

VP8, VP9WebM (.webm)
  VP7

WMV V8WMV – Windows Media Video (.wmv)
  WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile, MPEG-4,

WMV 9.1 Image V2
WTV (.wtv)   H.264, MPEG-2

 
Audio formats Input Output

 
Supported codecs

AAC – Advanced Audio Coding (.aac) AAC
AIFF (.aif,.aiff)   AIFF
APE – Monkey's Audio (.ape)   Monkey's Audio
Au (.au, .snd)   WAV
FLAC – Free Lossless Audio Codec (.flac) FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3
MPEG-4 (.m4a) AAC, ALAC
MPEG-4 ( .m4b)   AAC, PCM
Opus (.opus)   Opus
OGG – Ogg Audio (.ogg) Vorbis

PCMWAV – Waveform Audio File Format (.wav)
  AAC, MP3

WMA – Windows Media Audio (.wma) WMA 9
    WMA Pro, WMA Voice

Image formats Input Output  
APNG (.apng)    
BMP (.bmp)  
DPX (.dpx)    
GIF (.gif)  
JPEG (.jpg)  
JPEG (.jpeg, .jpg, .jp2, .jls)    
Netpbm formats (.pgm, .pbm, .ppm, .pam)    
PCX (.pcx)    
PNG (.png)  
PTX (.ptx)    
SGI (.sgi)    
TARGA (.tga)    
TIFF (.tiff)  
WebP (.webp)    
XBM (.xbm)    
XWD (.xwd)    
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Updating graphics card drivers

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card
manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update
is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications
and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section.
Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look
for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will
automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you
to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try
the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

Updating AMD® or ATI® Driver
 
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Download Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page
and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
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If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.
 
 

OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi Video Suite, your computer most likely does not support the necessary
version of OpenGL. To run Movavi Video Suite, your computer needs to support at least OpenGL version 2.0, and version 2.1 is required for
smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics
cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:
 
Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation
file from the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
 
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Suite. If you see an error
message again, proceed to the next step.
 
Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
 
In the message you see after starting Movavi Video Suite, select the Download and install software OpenGL implementation box.
 
Or, in the main Movavi Video Suite window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Video
Suite.
 
If these steps haven't helped:
•  Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
•  Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Hardware acceleration
Movavi Video Suite is optimized for the latest Intel® and NVIDIA® hardware acceleration technologies.
 
Intel acceleration
Movavi Video Suite supports hardware acceleration provided by Intel® multi-core processors and integrated graphics, which allows for faster
encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full power of each core. Performance grows
up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed simultaneously.
 
Supported Formats
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec; WMV
with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.
 
NVIDIA acceleration
If your computer is equipped with an NVIDIA® graphics card, you can use it to accelerate media file processing up to 5x by shifting a part of
the workload to the graphics processing unit, freeing up your computer's CPU for other tasks. This technology supports the newest NVIDIA®
graphics cards, including GeForce™, GeForce Mobile, Quadro, and Quadro Mobile. You can find the full list of supported GPUs on our webpage.
 
Supported Formats:

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
https://www.movavi.com/support/contact.html
http://www.movavi.com/videoeditor/performance.html
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Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec, MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec, WMV
with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec.
 
Enabling hardware acceleration
To enable Intel or NVIDIA acceleration in Screen Capture, or Video Converter: 
1. Open the Settings menu and select Preferences.
2. In the Preferences window, select the acceleration method that is compatible with your computer.
3. Click OK to accept the changes.
 
To enable Intel or NVIDIA acceleration in the Video Editor:
1. Open the Edit menu and select Preferences.
2. In the Preferences window, switch to the Acceleration tab.
3. Select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration methods for each
of the supported codecs.
3. Click OK to accept the changes.
 

Troubleshooting
If the acceleration option is unavailable it may mean one of the following:
•  Your computer is not equipped with the right hardware
•  The driver may be out of date or not installed.
Intel Download Center
Updating graphics card drivers

SuperSpeed mode
With SuperSpeed mode, you can convert videos much faster to compatible formats. You can use SuperSpeed mode in the converter and screen
capture modules.
 
How does it work?
When you convert videos, encoding the video from one codec to another usually takes the most time. In SuperSpeed mode, the video can be
converted without changing the video codec, simply 'transferring' the video stream from one file to another with zero quality loss. Converting a file
in SuperSpeed mode takes little more than simply copying it.
 
Since SuperSpeed mode does not modify the video stream, you can't use it if you want to add a watermark, adjust the video, or compress the file
to a smaller size.
 
Enabling SuperSpeed
1. Open the application settings and make sure that the Enable SuperSpeed mode option is on.

2. When choosing an output format, select one with the SuperSpeed icon: 
 
 

Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply with
patent law.
 
Activate codecs on demand
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
 
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.
 
3. Click Activate to complete the codec activation.
 
Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated even
if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.
 
What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were used.

https://downloadcenter.intel.com/
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